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Version 10.4.1 −−−− March 15, 2012 

Hyperview: 

1. Platform: 

a. Hyperview for Windows 2000 will be frozen at 10.4.1.  There are now two versions 

on Hyperview, one (frozen at 10.4.1) for Windows 2000, and one for other platforms.  

The correct version should be installed on your system automatically. 

2. Watch Window improvements: 

a. Support for scheduled paused was added to the Watch Window.  Blocks and groups 

can now be configured to automatically stop collecting live data at a certain time, or 

after a certain collection period.  

b. Data exported from the Watch Window now has a set number of significant digits 

rather that a set number of decimal places. 

3. Live Data support: 

a. Continued improvements to the ability to fetch and display live data via RoviSys 

Turbo. 

b. Standardized live data significant figure display on CAD sheets. 

c. Corrected problems in the significant digits formatting of live data for data fetched via 

RoviSys Turbo. 

d. A memory leak that could be encountered when an unavailable CIUMon was present 

in a server settings list was corrected. 

e. Various issues concerning socket-port over-consumption in certain circumstances 

were addressed. 

f. Live data is no longer fetched for blocks without a source that are not explicitly 

marked as external in BuildPlus.  Live data fetching can be forced for any block by 

making a live loop annotation or adding it to the Watch Window. 

g. “Camera/Snapshot” live data collection mode has been changed to “Slow” mode.  

Previously, data was refreshed in this mode only when a document was loaded, or 

zoomed, scrolled etc.  Now, the data is refreshed in these circumstances, and also 

every ten seconds. 

4. Display improvements: 

a. Vegas Lights were made to hug their hotspots more closely in order to avoid 

obscuring nearby text. 

b. Hotspots specified on the command line (e.g. with /tag) are centered on the display 

when Hyperview starts. 

5. Printing support: 

a. Fixed F(x) plots printing on black background bug. 

b. Loop/PCU/Module/Block search results no longer print garbage when blank. 

c. Fixed AutoCAD printing “cut off” under certain circumstances. 

6. Command Line support 

a. Comprehensive rework of command line specification of documents.   Document 

types are more consistently specified now, and documents of different types with the 

same names are correctly distinguished.  Name matching on partially specified names 

is handled more sensibly. 
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BuildPlus:  

1. Batch file processing has been improved: 

a. Batch files have been reorganized to appear in LPM chapters for ease of use. (5505) 

b. As well, some reworking has been done to suppress batch files from the configuration 

when named in an #INCLUDE statement.  

c. Batch titles have been improved.  BuildPlus will now use either the #descriptor field, 

the #title field or the filename.  

2. BuildPlus now creates a .CSV file which contains information about all the files being built 

into a particular project.  It will contain the filename, time and date the file was last modified 

and the file size.  This file, named <project_name>_file_statistics.csv, will be located in the 

ERROR_FILES directory.  

3. General memory and resource leaks have been cleaned up.  

4. The DBDOC build system has been frozen at the 10.4 release for Windows 2000.  

5. User defined scripts have been reworked to allow the user to specify a script to be executed 

before, during (before the hyperlink run) or after the build.  Only one of each type of script is 

allowed.  These can be defined on the "Processing Options" page in the "Project Options".  

CIUMon:  

1. Handling has been added to CIUMon when running in relay mode to improve confirmation of 

successful communication to upstream CIUMons.  This will help to prevent loops and to 

prevent unnecessary traffic when responses are known to be not available.  

2. A CIUMonController crash has been fixed when saving summary statistics .csv on certain 

platforms.  

3. Detection of open configurations has been improved.  Configurations opened under different 

logins or running as a service not interacting with a desktop will now be correctly detected 

under all conditions so that they cannot be opened in another instance of CIUMon.  

4. Changes have been made to increase the efficiency of working with the RoviSys turbo fetches: 

a. Like type data points are now grouped together in single bulk fetches to allow for 

quicker response from RoviSys for the known blocks.  

b. Unknown blocks (those that have not been fetched before) will be sent in a bulk fetch 

rather than as individual "read output" requests.  This prevents receiving possible 

failures for an unsupported 0x50 read output command and thus delaying the response 

by having to fall back to the older 0x14 read output command.  

c. Any data that has been marked as stale by RoviSys Turbo will also be in turned 

marked stale in the response returned to Hyperview / CIULink. 

d. CIUMon will now retain block information (block data types) between runs so that it 

does not have to re-establish the type each time it is restarted.  This will allow for 

efficient bulk fetches right from start-up.  

e. The number of non-turbo fetchable blocks for each bulk fetch has been lowered to 4 to 

allow for quicker response.  

f. CIUMon now uses the Module Status command for its connection status check so as 

to not confuse the block timing in RoviSys Turbo by requesting the output of an actual 

block at intermittent intervals.  

 

VirtualPortSetup:  
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1. The first VSP that can be created is now the first available port.  Lower port numbers are no 

longer being reserved.  

2. A problem with not being able to completely delete or uninstall virtual serial ports has been 

resolved.  

Hyperlink:  

1. New messages are being generated: 

a. For Function Code 45 - digital tags that have S2=2 in their DO/L block but have 

Alarm Group either (a) not set to 0 or (b) set to 99.  They cannot alarm but it might be 

the case that they are intended to alarm. (8243) 

b. For Function Code 31 - a TSTQ block is being used to test a signal that does not have 

the Quality attribute, or the signal being tested has no quality to propagate.  A check 

message has also been added to allow the user to examine logic to make sure that bad 

quality source values will be detected if that is intended.  The analysis of imported 

quality will also report when a block propagates quality.  (9558, 9655) 

c. Redundant Analog Input and Redundant Digital Input blocks need specific input and 

specification settings to function validly.  New messages try to alert the user to 

possible invalid usage. (9626)  

2. Additionally, some situations which were previously being reported as errors have been 

downgraded or removed. 

a. Tag not used on primary display message  removed  

b. Tags will not be reported as having no source if it is not used on a graphic, only in the 

Primary Display or Alarm Vector sense.   

c. Unwired REDAI and REDDI blocks will not be reported as an error.   

3. The rendering of AutoCAD drawings has been speeded up.  

4. Symbols are now listed on the Cross-Reference page if used on the graphic even if they are 

not displayed by DBDOC.  

5. HPG800 module type support has been added.   

6. Support for CLIF blocks has been improved.   

7. Links on tags and slave "pseudotags" on AutoCAD sheets have been improved with changes 

made to the partial tag matching code.  

8. Problem with displaying dynamic bars on some Conductor graphics has been fixed.  

9. Implement wiring for WinCAD to take advantage of logic based on Composer wiring. 

10. Wiring of Multi-input FCs 63-64 (AIL/B,DIL/B) 

  

DataFiles:  

1. Re-ordering of the error messages allow for the negative block messages to be grouped 

together rather than dispersed among other messages.   

2. Elevated priority of some generated error messages and improved wording on some others.  

 

Wizard:  

1. Various memory and resource leaks have been cleaned up.   

2. .Tiff files have been added to the Wizard file selection handling.   
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Version 10.4 −−−− June 30, 2011 

Hyperview: 

1. A number of Watch Window improvements have been made:  

a. Watch Window data is no longer loaded into memory, but instead is loaded from file 

as needed for displaying.  The practical size of trend plot datasets is thus no longer 

limited by available memory, but instead by system file size limits and disk space 

available. In other words, you can have as many 2 gigabyte datafiles as you have disk 

space for.  Display of plot data on startup is now instantaneous – no load time is 

required.  

b. Tag names and block descriptions are exported as part of the block value title when 

data is exported from the Watch Window. 

 

2. The live loop setup , where CIUMon server locations are specified, has been substantially 

improved.   New features include the following: 

a. M14 files can now contain multiple lists of CIUMon servers in different network 

contexts (typically one for the DCS LAN and one for the business LAN).  Hyperview 

will attempt to select the list automatically, though it can also be selected by the user. 

b. Local custom live loop settings are now persistent, and can be selected instead of the 

setting built into the M14. 

c. More complete and consistent connection status information is displayed in the 

browser status bar, the tooltip of the statusbar connection icon, and in the live loop 

setup dialog.  

d. Information about which loop (and pcu) the CIU (or serial port module) a CIUMon is 

connected to is located on is now fetched from the CIUMon itself.  

e. The CIUMon actually used for data fetch requests from a particular loop is indicated 

in the live loop setup dialog. 

f. Where more than one CIUMon option exists, Hyperview attempts to route data 

requests in the most efficient manner depending on the loop of the desired data.  The 

chosen routing is shown in the live loop setup dialog. 

g. This automatic routing can be overridden by the use of “routing preferences” 

h. CIUMons can be marked as “ignored” which causes them to not be used, but without 

needing to be deleted.  

 

3. Links to external PDF and TIFF documents can now be built into the M14 file and displayed 

from Hyperview.   The file path is included in the M14, but alternate paths can be specified 

from within Hyperview.   When links to external function code documentation is built into the 

M14, Hyperview displays it automatically when function code help is requested.  

 

4. Live input and output values are now plotted on function code 1 F(x) graphs, along with the 

previously plotted live spec values.   The live plot is now updated in the same mode as the 

underlying CAD/CLD diagram (i.e. snapshot mode or continuous), although it can also be 

refreshed on demand. 
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5. The presence of signal quality is now shown statically on CAD/CLD diagrams with “blue 

lines”.  When live data is turned on, the lines can become purple if the signal has bad quality. 

 

6. The Audit Window now shows a count of child branches.  

 

7. Live data colors have been reworked to improve consistency among data on documents, live 

loop annotations, F(x) graphs and watch window data.   The following conventions are now 

applied: 

a. Green:  live data with good status.  Previously it was sometimes dark blue, sometimes, 

green, sometimes light blue. 

b. Gray: stale data .  The stale color is now gray, not red.  This shows up most obviously 

in live data on documents, snapshot mode and in the watch window where red clocks 

are now gray.  A general pattern of "graying" out other live data colors has been 

implemented to indicate staleness. 

c. Orange: blocked data.  Can be seen in the status bar, in the live loop setup connection 

display, and for data on documents. 

d. Red: error.   Red is error or can't get data due to no connection. 

e. Light blue: no route to data.  Can't get data due to no connection to the specific data 

location (e.g wrong serial port module) 

f. Dark blue: quality and good quality.    

g. Purple:  bad quality. 

 

8. Various fixes and improvements to live data displays have been made including the following: 

a. If logic state labels have been misconfigured so that both 0 and 1 values have the 

same label, the label is suppressed, and the actual value is shown. 

b. Display of significant figures for live data has been made more consistent.  In general 

five significant figures are displayed. 

  

9. A number of printing bugs were addressed, including printing of AutoCAD files, which was 

failing to print the entire sheet under some circumstances. 

 

10. Hyperlink now preserves upper and lower case in document names built into the M14.  This 

means that Hyperview bookmarks and annotations that were created on affected documents in 

M14s before this change may be “lost” or “disabled”.  They are easily recoverable. Contact 

GMCL. 

BuildPlus:  

1. BuildRoot and project settings are now stored in hash tables which are dumped to files in a 

known location.  The settings were previously stored in the registry which limited which users 

(those with Administrator privileges) could perform builds.  With this new scheme, any user 

with access to BuildPlus should be able to perform builds. 

 

2. The Live Loop / CIUMon Settings options have been revamped. 

 

 

3. BuildPlus will now use the WinMerge program for its file/folder comparison tool. 
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4. Builds can now be performed on 64-bit platforms. 

 

5. AutoCAD file processing has been sped up during the configurator stage of the build. 

 

6. Handling has been changed to improve the paths and titles displayed in the Table of Contents 

of the .M14 in Hyperview. 

 

7. MDB_Extractor has been reworked so that it utilitzes ADO rather than DAOSDK.  BuildPlus 

has been modified to support these changes and to remove any DAOSDK support. 

 

8. If multiple copies of BuildPlus are running at the same time, you will now be prevented from 

building the same project in more than one instance of BuildPlus. 

 

9. A new feature has been implemented to allow you to revert a project to its previous settings.  

This will only work if you have the "Archive Project Error Files" option turned on in the 

BuildRoot Options so that the necessary files are generated and stored for the reversion.  

Under the "Tools" menu, choose "Revert to a Previous Build..." and choose the project .nod 

file from the date that you want to revert to from your archived error file location. 

 

10. Various memory and resource leaks have been cleaned up. 

 

11. You can now choose to build in your Function Code .PDF files into your .M14 file so that you 

can easily access the information.  The option can be seen on the "Database Specification" 

panel (start a project from the GO button) or you will be queried if you wish to include these 

files the first time you do a rebuild of an existing project.  

CIUMon:  

1. New versions of the virtual serial port files have been released. 

 

2. The user can now specify the location where CIUMon will write and store its logs. 

 

3. There is a new logging option - error activated logging.  Logging will not start in CIUMon 

until it encounters an error in one of the responses from the CIU.  CIUMon keeps a buffer of 

the past responses so you can specify the number of minutes of information that CIUMon 

should write to the log when it sees an error.  You can also specify the number of minutes 

after the error that CIUMon should continue logging before it stops. 

 

4. The RoviSys OPC90Server program has a few new features to note: 

 

a. There is now the option to connect via a virtual port connection in the MUXCIU 

block.  This will allow CIUMon to connect to it without the need of an actual port.  

Choose this option on CIUMon's "Communication Modes" page in the CIUMon 

settings. 
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b. RoviSys has implemented a new MUXCIU Read Block Output List command which 

allows for the fetch of multiple block values in a single request.  This greatly 

improves the data collection throughput by taking advantage of the OPC90 turbo 

polling provided. 

 

5. CIUMon uses fewer deferred keys thus improving response times.  The default is set at 4 but 

can be modified in the CIUMon settings. 

 

6. CIUMon will now attempt to use the 0x50 command in place of the 0x14 for the read output 

requests.  The 0x50 command will return 4 byte reals for a response rather than 3 bytes ones, 

allowing for greater precision.  If the command is not supported by a given CIU then CIUMon 

will revert back to using the 0x14 command. 

 

7. Text data support for function code 194 has been added. 

 

8. CIUMon will work now if UAC (User Account Control) is turned on. 

Hyperlink: 

1. Blue Line for Quality, Purple for Bad Quality — In CLD and CAD sheets, all signals that 

have the quality attribute are shown in blue.  If the signal is bad, live data shows the line in 

purple.  

 

2. Live Data on References  — The value of signals is shown on input and output references.  

This is a major enhancement when logic is done using pre-programmed macros.  

 

3. Link to Function Code PDF files — Links on Help and Function Code blocks are built to the 

Composer and WinCAD PDF function code documentation.  

 

4. Support of Formatting in SODG Graphics — The formatting in SODG graphics that defines 

the number of digits to display is implemented.  

 

5. AutoCAD Attributes, Linking and Printing Improvements 

1. Improvements have been made to make generation of links to tags and slave references on 

AutoCAD sheets much more effective by editing a simple text file.  

2. Links to generic XLS files have been made possible.  

3. Printing of AutoCAD sheets always is done with a white background.  

 

6. Support of MTLink in 800xA Graphics — A common linking technique in 800xA VB 

graphics has been implemented.  

 

7. Corrected Nordic Character Support — Support for Nordic (and other codepage) characters 

has been corrected. 

 

8. Support for FC 194 (text string output) implemented. 
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9. File names are no longer converted to upper case when compiled into the M14.  This change 

may bookmarks and annotations that were made in Hyperview on earlier builds (on documents 

with lower case letters in the names) to be “lost” or “disabled”.   Any affected  bookmarks and 

annotations can be readily retrieved – contact GMCL.   

 

10. Composer version 5.1 is supported. 

 

11. Improvements in Error Checking and Compiling  

 

a. Report Logic States if Same 

b. RESTOR Block Order Test 

c. Tag Found in Other Database Resolved 

d. Composer and Access Wildcard Chars 

e. More Similar Tags 

f. Tag addded on multilevel alarm message 

g. List nested inhibits. 

h. Alarm Inhibits in Composer 

i. Spec Extraction - Large Values 

j. Links on Blocks in B90 Files 

k. FCConstraints quirks 

l. Block map and Segment Control Blocks 

m. Tagname in Significant change report 
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Version 10.3.1 −−−− October 12, 2009                                                                                                 

BuildPlus: 

1. Corrected handling when building multiple Access .MDB type databases into a single build.  

(7839) 

 

2. Fixed a hang in processing during the Management of Change stage when an empty or 

misconstructed datbase file is encountered.  (7682) 

 

3. BuildPlus will now check to see if the user has the necessary administrator privileges in order 

to use the program.  On Windows Vista it will perform the additional check of seeing if User 

Account Control is turned off before proceeding.  If either of these conditions is not met then a 

message box warning the user will appear and BuildPlus will exit.  (7925) 

 

4. For PPA projects, BuildPlus will now parse the file ppa_graphics.txt to guide the user in 

selecting which folders are graphics or submodels. (8001) 

 

5. Automatic generation of Conductor NT consoles in BuildPlus has been improved.  BuildPlus 

can now do the correct associations for the  XDC and DAT files if they are placed in a logical 

location in the Conductor NT file structure.  (8011) 

 

6. Currently you can only include one 800xA project in any one particular build.  In the future, 

we hope to support the ability to inlcude multiple 800xA projects in one build.  (8078) 

 

7. Handling has been added so that 800xA graphics and submodels will be tracked and reported 

in Management of Change.  (8102) 

 

8. Memory and resource leaks have been fixed.  (8110) 

CIUMon: 

1. All of the CIUMon service options have been incorporated into one dialog for ease of use.  

(7026) 

 

2. A bug in the TRAX simulation handling where CIUMon was unable to fetch the output values 

for blocks numbered above 4095 when the  tag indexing scheme was employed has been 

fixed.  (7565) 

 

3. A new option to create hourly logs has been added.  (7582) 

 

4. Fixed internal setting of CIU type for an ICI03 so that the correct request and response 

handling would be triggered.  (7727) 

 

5. Corrected CIUMon retries on initial connect - if it fails to get a response to its environment 

request then it continues to retry every five seconds until a good response is received.  



 DBDOC Release Notes          
 
 

 
DBDOC for ABB

®
 INFI90

®
 Systems copyright © 1996 – 2012 by G. Michaels Consulting Ltd.   ABB and INFI 90 

are registered trademarks of ABB Automation.    
 
2/29/2012        DBDOC Release Notes — Page 10 of 95 

Although the messages in the window reported the request was being re-sent, it actually was 

not; this has been fixed.  (7913) 

 

6. CIUMon will now check to see if the user has the necessary administrator privileges in order 

to use the program.  On Windows Vista it will perform the additional check of seeing if User 

Account Control is turned off before proceeding.  If either of these conditions is not met then a 

message box warning the user will appear and CIUMon will exit.  (7925) 

 

7. CIUMon services interacting the desktop when stopped and restarted will now retain their 

previous connection setting.  That is, if a service was connected before, it will be connected 

after the restart and vice-versa.  (7730) 

DataFiles: 

1. Errfilter.cfg updated for new and existing error messages. 

2. Tagatoms.txt has been updated with new entries. 

3. Corrections made to output.txt. 

4. New and updated TTG text and database files have been included. 

Decomposer: 

1. Decomposer now exits cleanly (i.e. does not crash) when a corrupted or unsupported file is 

encountered.  (8021) 

Hyperlink: 

1. Additional links are now being created on trend submodels.  (4453) 

 

2. A crash in the batch file handling dealing with the continuation line character has been fixed.  

(7680) 

 

3. EGU text display on 800xA graphics has been corrected.  (7738) 

 

4. Links to tags that were previously lost have been reinstated.  (7745) 

 

5. The ADVBPOEXTENDEDPRIMITIVESLibCtl.AdvantBarLimits type dynamic bar is now 

properly displayed on graphics.  (7753) 

 

6. Text positioning and wrapping on 800xA graphics have been corrected. (7754, 7765) 

 

7. HIGH and LOW limits now appear on 800xA graphics.  (7899) 

 

8. For station tags, PV references get the @PV tag and SP references get to the @SP block.  

(7958) 

9. For 800xA systems, hyperlink will now use the full functional structure view on graphics.  

(8035) 

 



 DBDOC Release Notes          
 
 

 
DBDOC for ABB

®
 INFI90

®
 Systems copyright © 1996 – 2012 by G. Michaels Consulting Ltd.   ABB and INFI 90 

are registered trademarks of ABB Automation.    
 
2/29/2012        DBDOC Release Notes — Page 11 of 95 

10. The handling of long filenames and/or paths in AutoCAD which caused Hyperlink to crash 

has now been fixed.  (8141) 

Hyperview: 

1. Hyperview will now automatically close and restart when the GDI or User object threshold 

has been reached to avoid hanging/crashing. (8176) 

 

2. Memory leaks in 800xA graphics handling have been fixed.  (8177) 

Node: 

1. Memory leaks have been cleaned up.  (8177) 

Wizard: 

1. Speed when searching through large data sets, selecting/deselecting files/folders from long 

lists and performing duplicate file comparisons has been vastly improved.  (5226, 7481, 8009) 
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Version 10.3 −−−− March 24, 2009 
 

** Note - DBDOC now supports 800xA graphics.  To include them in your project,  

          please see the folder "800xA Instructions" on the CD. 

Hyperview: 

1. Additional Watch Window features have been implemented: 

a. The update interval for a block is now displayed and can be updated directly in the 

block list. 

b. You can now set the update interval for an entire group of blocks at once via the group 

menu. 

c. Plot line colors can now be specified for blocks in the Watch Window. 

d. Plot description text is now displayed right on the plot itself. 

e. Improved handling of "out of memory" situation if too much data is collected for the 

resources available.  Data collection stops. 

 

2. 800xA graphics can now be displayed in Hyperview.  To display 800xA graphics, you need to 

register certain DLLs. To do this, run  .../Program Files/GMCL/DBDOC/PROGRAMS/PPA-

DLLs/PPA-DLLs.exe – this will extract a mini-installer that will register the 800xA DLLs 

appropriately.  If your system does not have 800xA graphics, it is not necessary to do this.  

 

3. The Go To Use feature for blocks has been extended -- the source of a value is now shown as 

one of the uses, and Go To Use can be called from a use (previously you could only Go To 

Use from a block source).  

 

4. Projects (M14 files) that have been "moved" (renamed) in BuildPlus are now handled 

correctly.  Previously, renaming a project in BuildPlus led to the loss of some or all of the user 

data files (representing  annotations, live loop annotations, watch window data, bookmarks, 

history etc).  Renaming the user data files to match the new project name was not sufficient to 

retain the user data because many of these  files contain internal references to the project 

name.  As of 10.3,  if you load a project that looks new (has no user data files), Hyperview  

will ask if it is a renamed project.  If it is, you will be prompted to identify the project's former 

name.  All the user data files associated with the former project name will be copied, renamed, 

and converted to work with the new project.   

 

5. Searching & search results have been updated in several ways: 

a. The text search dialog has been reorganized and clarified. 

b. The Loop-PCU-Module-Block is now displayed in the search results list when 

appropriate. 

c. For text searches, when the search result is a block, Go To that search result causes 

the relevant part of the configuration (where the block is used as a source or input) to 

be displayed in the content pane.  The block index is displayed in the index pane as 

before. 

d. For database searches, Go To search result causes the block source (not the database 

listing) to be displayed in the content pane. 
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e. For topic title searches, Go To search result causes the block source in the 

configuration to be displayed in the content pane whenever the search result is a block 

index. 

 

6. The Loop Setup list in the Live Loop Setup tab of the Options Dialog now indicates 

connection status by color: black=connected, gray=not connected, red=blocked.  The 

checkboxes that used to indicated connection status have been removed.  

 

7. Updated support for "blocked" live loop connections: 

a. A new "blocked" icon has been added to the Hyperview status bar to indicate that this 

Hyperview is not allowed to fetch data from any  specified CIUMon. 

b. Avoid initiating data requests on known blocked connections. 

 

8. External blocks are now shown in the Audit Window. 

 

9. Open Document feature (removed in 10.2.1) has been put back. 

 

10. If any PCU specific connection is available, live loop data which is  inaccessible is displayed 

in blue (as opposed to red). 

 

11. Hyperview now has a reasonable minimum window size. 

 

12. The old live loop logging feature has been removed.  Use the Watch Window to log live data 

of interest. 

CIUMon: 

1. Improvements to CIUMon's data throughput capabilities. Data rate increase will vary by 

system. 

 

2. Improvements to CIUMon's ability to be run for long periods of time without manual restart: 

a. CIUMon is restarted by a watchdog application if it is detected using "too much" CPU 

time (generally meaning that it is "hung"). 

b. CIUMon is restarted if it is unresponsive to status requests from  the watchdog. 

c. CIUMon is restarted periodically if it is not busy fetching data.  This is to 

preemptively prevent situations where it becomes unresponsive.  

 

3. Improvements to CIUMon logging: 

a. Users can choose either "Rolling" or "Daily" logs. 

b. In Rolling Log mode, users can specify how many logs (up to 10) of  what size to 

maintain.  The oldest log is deleted whenever the limits are reached.  A new file is 

always started at midnight regardless of whether the limits have been reached. This 

mode uses bounded disk space. 

c. In Daily Log mode, users can specify the maximum size (or unlimited size) for a log 

to be created at midnight each day.   

d. CIUMon logging details (e.g. file size) can now be modified on the fly via 

CIUMonController. 
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4. Upgraded to use CrypKey version 7.1. 

BuildPlus: 

1. New file types supported in builds: 

a. 800xA graphics 

b. 800xA MDB files 

c. CLT files for Composer 

 

2. BuildPlus will now allow the build to continue if a database previously included in the project 

is found to be "missing". 

 

3. Support for copying (Cloning) and renaming (Moving) projects.  

 

4. Upgrade to CrypKey version 7.1. 

Wizard: 

1. Supports 800xA graphics. 

Hyperlink: 

1. There is now beta-level support for 800xA graphics in DBDOC projects. 

a. General support for linking 800xA graphics into the M14 project 

b. Support for MDB Configserver database files 

 

2. There is support for newer AutoCAD versions and more accurate presentation of some 

AutoCAD content. Unicode text is supported on AutoCAD files, and may yield tag links. 

 

3. Unicode paths and filenames are fully supported. 

 

2. New checks for errors and misconfigurations: 

a. Check that TSTQ Test Quality blocks are actually checking valid quality attributes. 

b. Tags that inhibit alarms on other values are now reported.  Nested and circular inhibits 

are also reported. 

c. TSTALM blocks that reference a different page are reported. 

d. Orphaned ADAPT blocks are now flagged. 

e. "Not a valid M1 file" error now reports name of problematic file. 

 

5. A new Significant Change Report is generated. This report helps catch misconfigurations 

(including in Ladder files) that can lead to exception reports erroneously not being generated 

immediately despite significant  changes in values.   

 

6. Updated document display details (visible in Hyperview): 

a. Import blocks now show "External Source" in the bubble if the source does not exist 

in the M14 file. 



 DBDOC Release Notes          
 
 

 
DBDOC for ABB

®
 INFI90

®
 Systems copyright © 1996 – 2012 by G. Michaels Consulting Ltd.   ABB and INFI 90 

are registered trademarks of ABB Automation.    
 
2/29/2012        DBDOC Release Notes — Page 15 of 95 

b. A ">" now indicates the presence of links between test alarm blocks (TSTALM) and 

their inputs. 

c. Composer titles for modules, PCUs and loops are shown in classic TOC. 

d. Display of vertical text has been significantly improved. 

 

7. Very large systems are built to show more than one block on block index  pages (two per page 

is sufficient for the few systems that will encounter this).   Previously these systems could not 

be built in a single M14. 

 

8. Update support for Loop-PCU-Module-Block links 

a. Now correctly generated for PI sourced points. 

b. Now supported for generic database files. 

 

9. Slave tags are generated for FC 137 BASROQ and FC 138 BASBOQ blocks. 

 

10. More information (database name, path to graphic file) is shown in the "Tags in Graphics.dbf" 

file. 

 

 



 DBDOC Release Notes          
 
 

 
DBDOC for ABB

®
 INFI90

®
 Systems copyright © 1996 – 2012 by G. Michaels Consulting Ltd.   ABB and INFI 90 

are registered trademarks of ABB Automation.    
 
2/29/2012        DBDOC Release Notes — Page 16 of 95 

Version 10.2.1 −−−− August 7, 2008 
 

Critical Improvements: 

� Watch Window loading of data has been sped up drastically 

� Hyperview stop CIUMon from fetching new data when it changes pages 

� CIUMon stops getting data that Hyperview says is no longer needed 

� CIUMon handles many timing and error conditions better 

� Go To Use feature has been created to make full screen navigation easy 

Hyperview: 

1. Many Watch Window improvements and features have been implemented: 

a. Data files for the Watch Window are now loaded in the background  when Hyperview 

is opened so as to not stall other operations.  For large datasets, you will see a progress 

bar on the block list to indicate that a load is underway; it will disappear once the  

load is completed. 

b. The ability to delete data for a block in the Watch Window is now supported.  Select 

the range of data you wish to delete and click  on the "Delete Data" button on the 

toolbar. 

c. You can now quickly navigate to any timestamps that you may have created on the 

Watch Window.  You can use the buttons located at the bottom of the Watch Window 

to go to the first, previous, next or last timestamp and it will automatically center it in 

the window.   As well, if you scroll away from the currently selected timestamp  you 

can press the "Jump to selected timestamp" button to get you back. 

d. The option to invert the axis has been added to the Watch Window. 

e. The option to "Go To Source" and "Go To Block Map" has been added to Watch 

Window.  Right click on a block to bring up the context menu and select the option. 

 

2. With the implementation of the Watch Window, plots have been removed from live loop 

annotations.  Pre-existing live loop annotations with plots will be automatically converted into 

Watch Window plots on the initial start up of the new Hyperview. 

 

3. Support has been added to ask for the Module status and to display the data appropriately.  

You can ask for this data by launching the "Define Live Loop Annotation" dialog, selecting 

the "Module Status" radio button and specifying the Loop, PCU and Module that you want the 

status of. 

 

4. Data points for live loop annotations and continuous monitoring are fetched at the start of their 

timer cycles so that a fresh value will be displayed if the user chooses to modify the update 

interval. 

 

5. Retrace Extension has implemented a "Go to Use" capability. 

 

6. The "/block" command line qualifier has been added.  The format for the switch is as follows:  

/block="Module L,PP,MM Block BBBB".  Hyperview will call up the specified source block. 
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7. Hyperview will now send a terminate_request command to CIUMon when live loop 

monitoring is on and it moves on to a different document.  This will allow CIUMon to discard 

any outstanding requests that it may have queued up and lessen the load to the CIU by not 

sending requests that are no longer valid. 

 

8. You can now use the 'M' key to turn on snapshot monitoring; 'Shift-M' will turn it off.  

Pressing F5 in snapshot mode will refresh the data. 

 

9. Choose what document Hyperview will open to when it starts up by setting it in "Options | 

View".  You can choose to have it open up to the last viewed page or the Home Page that you 

set by clicking on the appropriate radio button. 

CIUMon: 

1. Demand Module Status command handling has been added. 

 

2. Better error recovery has been implemented for the following error codes: 

a. 31 - Checksum Compare Error 

b. 32 - Destination node offline 

c. 39 - Destination ring offline 

d. 40 - Destination node busy 

e. 41 - Destination ring busy 

f. 110 - Module not responding 

 

3. Error recovery in general has been improved. 

 

4. CIUMon has been modified to discard outstanding requests when it receives a 

"terminate_request" command from Hyperview.  It will not send obsolete requests to the CIU 

nor will it send any outstanding responses that it has back to Hyperview. 

 

5. A general cleanup of memory and resource leaks was done. 

 

6. When CIUMon is configured to run as a service and is not interacting with the desktop then it 

will autoconnect regardless of whether or not the user has this set up in the configuration. 

 

7. A bug where the OPC90Server was not getting launched when configured to in the options 

has been fixed. 

 

8. The timing of sending and receiving data has been improved. 

 

9. The display handling has been reworked and improved. 

 



 DBDOC Release Notes          
 
 

 
DBDOC for ABB

®
 INFI90

®
 Systems copyright © 1996 – 2012 by G. Michaels Consulting Ltd.   ABB and INFI 90 

are registered trademarks of ABB Automation.    
 
2/29/2012        DBDOC Release Notes — Page 18 of 95 

Version 10.2 −−−− February 11, 2008 

Hyperview: 

1. Many improvements and additions have been made to the Watch Window. 

a. Autoscaling - the Watch Window will automatically scale the plot to fit the minimum 

and maximum values of the point/group. 

b. Checkbox added to the block list  - if checked, the line associated to the block is 

shown; otherwise it is hidden 

c. Clock icon added at both block and group level shows the current live data gathering 

status. 

i. Green - Actively collecting data and is not stale 

ii. Red - Stale data 

iii. White - Data collection is paused. 

d. The state of the clock icon at group level can one color or a combination of colors to 

reflect the state of all the points in the given group. 

e. Export data for points to a .CSV file.  You can also choose to check the "Excel" 

checkbox to have the .CSV file opened up in Excel automatically after the export has 

been completed. 

f. Timestamps can now be deleted from the plot.  Click the [x] on the time label to 

delete it. 

g. You can copy a block from one group to another.  Choose "Copy Block to Group" 

from the context menu that appears on a right click. 

h. View each block in its own separate plot in the Watch Window.  You can toggle 

between a split or overlapped view of multiple plot plines. 

i. A legend appears in the lower right-hand corner of the Watch Window listing the 

block icons (show, pause, autoscale) and what they do. 

 

2. Stale data is now displayed correctly on ladder diagrams on rung function codes.  A red 

background rectangle is now drawn behind the point to indicate that it has gone stale while it 

shows the last known state in the box. 

 

3. Tooltips now appear on the block map to help explain the different types of blocks that appear. 

 

4. Fixed Y-coordinate display on graphics and CADs. 

 

5. The "Print Full Sheet" option now latches correctly so that the state is retained between runs. 

 

6. The following changes have been made to the shortcut keys: 

a. The "S" key now works the same as the "C" key for turning on/off Specs. 

b. The keyboard shortcut for next and previous search hit has been removed. 

c. The "Z" key now works as zoom toggle. 

d. The "+" and "=" keys zoom in while the "-" and "_" keys zoom out on the current 

document. 

 

7. General performance improvements and fixed memory leaks. 
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CIUMon: 

1. You can now limit the usage of CIUMon to get live data by username (previously limited by 

IP Address only).  Enter in the usernames the CIUMon options and specify whether or not the 

user is allowed to fetch live data.  If a user not allowed live data gathering then he will see the 

USER_BLOCKED message in Hyperview or CIULink. 

 

2. New usage statistics are now being collected in CIUMon.  CIUMon will track the username 

and IP Address of all requestors and the first time that they tried connecting to CIUMon.  You 

can see how many users have been monitoring with the current instance of CIUMon and who 

is currently active. 

 

3. CIUMon can be run in "Relay Mode" where it relays requests between two other instances of 

CIUMon.  This mode is used in situations where TCP/IP traffic is prohibited across more than 

one LAN. 

 

4. Incoming requests are now dequeued based on the weight of the user so that no one user can 

monopolize all of the bandwidth.  CIUMon will cycle through all of users and dequeue the 

requests allocated to a particular user before moving on to the next.  This allows for the usage 

to be spread out among all requestors. 

 

5. CIUMon has been converted to Unicode to be compatable with foreign language platforms. 

 

6. INICT13A support has been added. 

 

7. The newest version CIUMon now runs at high priority.  If you wish to change the priority 

level of CIUMon then you can access the "Set CIUMon Priority..." option from the "Options" 

menu. 

 

8. A new feature has been added for those users who have TRAX simulation software. You can 

now configure CIUMon to talk to the TRAX software to get emulated data for your system. 

 

9. You can now specify the interval at which CIUMon checks for a valid connection with the 

CIU.  This option can be found on the "Configuration" page of the CIUMon options.  If you 

wish to turn the automatic connection check off simply enter in an interval of zero. 

CIULink: 

1.  The sequence of data logging dialogs have been revamped for ease of use. 

    You will now be able to specify the type of logging (past, present 

    or both), the name of the file to log to and what type of data to 

    log from one location. 

 

2.  Live loop entries are no longer allowed after the demo setting has been added. 

 

3.  Some scrolling and display problems have been fixed. 
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Hyperlink: 

1. Positioning of vertical text on Conductor NT and PPB graphics has been fixed. 

 

2. The reference index now has links to off-module references. 

 

3. Hyperlink now generates a zero-length wire where input/output are overlaid to make a 

connection on WinCAD sheets. 

 

4. A group is now being made for all batch files so that files will be searchable. 

 

5. More data being read from the MHD file is now being displayed on the CAD sheet. 

 

6. Function code 229 support has been added. 

 

7. Spare inputs are now marked when the PCU, Module and Block are all equal to zero. 

 

8. Support for Displaynames.txt which was previously broken has been fixed. 

 

9. Hyperlink now generates an error message for inappropriate tagatoms that are found for 

Conductor NT or PPB. 

 

10. Additional coordinate information has been added to our live wire message  to aid in 

troubleshooting. 

 

11. DADIG has been added to the alarm tag function code list. 

 

12. Flat function discrepancies (function code 1) have been fixed. 

 

13. Non-exception report tags used on graphics are now reported. 

 

14. Two new lists are now generated by hyperlink:  TREND_ARCHIVE.TXT and 

TREND_UNUSED.TXT.  Trend tags that are not used on any graphic but have the 

TRUSAGE field set to ARCHIVE are listed in the first list.  Trend tags not used on any 

graphic and have the TRUSAGE field not set to ARCHIVE are listed in the second file; 

hyperlink generates a warning message as well for this condition. 

 

15. An error message is no longer generated for Function code 179 when S15 is set to zero. 

 

16. General hyperlink performance improvements should result in decreased runtime. 

Decomposer: 

1. Links on CAD sheets by document name have been corrected for Composer projects. 

 

2. Function code 247 I2 spec handling has been corrected.  
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3. Function code is now mentioned in errror messasges. 

DataFiles: 

1. Errfilter.cfg updated for new and existing error messages (trend errors, TSTALM block 

handling, QOR with 0 inputs). 

 

2. Tagatoms.txt has been updated with new entries. 

 

3. Corrections made to output.txt. 
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Version 10.1 −−−− September 13, 2007 

Hyperview: 

1. The new Watch Window feature allows you to plot multiple points on the same graph. The 

Watch Window is resizeable, rescaleable and printable. Points may be edited, added and/or 

deleted within the Watch Window. You may create multiple Watch Window groups to 

monitor different sets of points.  Data is plotted in real time with leading edge values.  Plots 

feature a timescale, crosshairs and timestamps. Timestamps persist across Hyperview runs. 

Import CIULink lists into a Watch Window group from an exported CIULink tag list or from 

a local registry.  Right click a hotspot or an existing Live Loop Annotation to add it to a watch 

window group. Data is collected and logged in .csv files by default and persits across 

Hyperview runs. Data can later be analyzed in Micosoft Excel. You may choose to not log 

data to a file. Collected data can be selectively deleted. 

 

2. The Snapshot operation has been modified.  Each time the camera button is pressed, new data 

will be fetched and displayed.  To turn off the snapshot feature, the button now needs to be 

double-clicked.  Also, if you zoom or change drawings while Snapshot mode is on then data 

will be refetched. 

 

3. Configurable data persistence and background collection for live loop monitoring has been 

implemented. 

 

4. You can now show Live Loop Annotation data graphically. These graphs are resizeable,  

rescaleable, scrollable, and you can add timestamps to the graphs. Data persists across 

hyperview runs by default. You may choose to log collected data to a file or not. Collected 

data can be selectively deleted. 

 

5. A button has been added to the toolbar for the creation of Live Loop Annotations. Continuous 

update live loop annotations are now flagged in the Annotation Manager. 

 

6. You now have the option to select full sheet printouts where the title, date, caption and 

zoombox are suppressed.  This option can be found in the "Advanced Print" options. 

 

7. For digital states, the symbol has been moved to appear after the logic state descriptor.  As 

well, you can now choose to suppress the logic state labels - the "Display Logic States" option 

is available under the "View" menu.  (5294, 5301) 

 

8. Various memory and resource leaks have been fixed. 

CIUMon: 

1. Handling for the NCIU01 type of CIU has been corrected. 

 

2. CIUMon now correctly handles error 105 - Undefined block number. The response CIUMon 

sends back to Hyperview and CIULink will correctly identify the point as being in error. 
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3. CIUMon has been updated to use CrypKey version 6.120. 

CIULink: 

1. Customizable logging options are now available for export view logging.  You can choose 

what data will be written to the log. 

 

2. A comma-separate variables (.CSV) file allows importation of CIULink data into other 

applications including MicroSoft Excel easily. 

 

3. CIULink has now been equipped with a new synchronized start/stop feature which allows for 

monitoring and logging to be turned on and off at a specified time. 

 

4. Logging now takes place to either the user specifed filename or to a default location - the 

"DBDOC LOGS" folder in your personal folder which, in most cases, is "My Documents".  In 

the default logging location, the log filename will have the date appended to it so that a new 

file will be generated each day. 

 

5. The CIULink saved settings have been moved from the HKEY_LOCAL_MACHINE registry 

key to HKEY_CURRENT_USER. 

 

6. This is the first release of the full unicode version of CIULink. 

 

7. When adding a point that is not found in a database, you can now enter a short description to 

describe it.  This description will be displayed in the "Tag" field in Export view. 

BuildPlus: 

1. Final version of DBDOC that supports 98/ME is released. 

 

2. Former "BuildPlus Options" are now applied at the buildroot level and have been so renamed.  

This allows you to set the options just for the projects in a  specific root rather than to all 

existing projects.  There are a few options that will still apply to all projects and they can be 

found in the new "Global Options". 

 

3. You now have the ability to specify the code page value that DBDOC will use to interpret 

your data. 

 

4. BuildPlus has been updated to use CrypKey version 6.120. 

Wizard: 

1. Module 1,00,00 chapters are now sorted alphabetically. 

 

2. Batch file processing speed has been greatly improved. 
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Hyperlink: 

1. Conductor NT tag atoms handling has been improved with the implementation of 

tagatoms.txt. 

 

2. Logical operator support in Conductor NT and Process Portal B has been added. 

 

3. A new error message now reports TSTALM blocks that test the same attribute of the same 

block. 

 

4. Tags with spaces in them are now handled properly in Process Portal B Graphics. 

 

5. Correction has been made to re-implement the display of SODG graphic titles in the M14. 

 

6. Hyperlink now generates a report of all CLD and CAD files with layer 5 used. The files 

Layer_5.txt and CADLAYER.DBF can be found in the Exports folder of the project directory. 

 

7. CLIF Block Spec handling has been corrected. 

Decomposer: 

1. Handling for function code 247, specs 30 and 31 has been added. 

Database Utilities: 

1. Database records with blank tagnames are now omitted. 

 

2. Text string support has been added for Conductor NT.  We now get the strings for logic states, 

alarm comments, engineering units descriptor and text selection text. 

Data Files: 

1. Errfilter.cfg updated for new and existing error messages. 

 

2. Output.txt modified for function codes 227, 228 and 229. 

 

3. New file tagatoms.txt has been added to handle Conductor NT tag atoms. 
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Version 10.0 −−−− March 6, 2006 

Wizard: 

1. There is now a special override checkbox specifically just for the module header files if 

you have chosen to build in CAD sheets.  If you choose only one MHD to build into your 

project, you must check the  "Single MHD" checkbox before the "Next" button is enabled. 

 

2. If you choose to build in your error files into the final M14, you can now change where 

the actual chapter of error files appears in  the M14.  Turn on the "Show re-order TOC in 

Wizard" option in the "Advanced Options" and in the Wizard, drag-and-drop the error 

files to where you want them to appear in your M14. 

BuildPlus: 

 

1. The printing in the "Management of Change - Print Changes" dialog has been fixed. 

 

2. The "Graphics-to-Symbols Associations" have been moved into the "Project Options". 

 

3. The database searching in the "Database Specification" dialog has been improved to provide 

for faster searching when looking for multiple database types. 

 

4. The "F5" key now refreshes the BuildPlus state (the same as the "Refresh" button on the 

toolbar). 

 

5. Support to make multiple database-graphics associations for global symbols has been added. 

 

6. You now have the option to copy the final M14 to multiple locations, instead of just a single 

location, upon the completion of a successful build.  This can be found on the "Processing 

Options” tab in the "Project Options". 

 

7. You can now specify different types of return code checks other than just "equal to" for the 

pre- and post-script processing runs. 

 

8. Handling has been added to support the new DBOPCCSV database utility. 

 

9. If you encounter the "Sort failure due to error 1" during your MediaView compile and you are 

building large database files, we may be able complete the compile with the databases 

processing re-ordered. In the "Processing Options | Advanced Options" check the "Process 

databases in order of descending number of tags" and try building again - it may make the 

problem go away. 

 

10. If error folder archiving is turned on, the name of the folder will now be the same as the M14 

file.  When the "Rename .M14 Document" option under the "Tools" menu is used, the 

associated archived error folder, if one exists, will also be renamed to follow that of the M14 

file. 
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11. Microstation drawings (.DGN) are now supported in our Management of  Change processing. 

 

12. At startup, BuildPlus will check to see if the dongle and its necessary drivers are present.  If 

they are not, BuildPlus will bring up a warning and give you a chance to install the drivers at 

that time.  If you want to check driver versions or intall/uninstall drivers, look under the 

"Tools" menu and click on the "Check Dongle Driver..." option. 

 

13. The log created during a buildall has been moved to the actual buildroot in which the buildall 

is occurring (the old location was the Log subfolder of the installation directory). 

Hyperlink: 

 

1. Hyperlink now requires that the DBDOC dongle be present before a build can proceed.  If you 

require a dongle, please contact GMCL to get onevsent to you. 

 

2. Output Reference Destinations now are displayed for Composer system localvoutput 

references (references within the same module). An index of unlinked graphics is now created 

to show all graphics that cannot be called by a built-in function from any other graphic.  It 

shows graphics that are orphaned, as well as ones that have been abandoned or never 

implemented. 

 

3. The adapt block target spec value is reported in the case of adapt blocks that are out of 

sequence.  This allows the user to inspect the messages looking for values that have not been 

initialized, a possible problem on switching modules.  

 

4. External output reference does not exist for IREF "xxxx" now lists the loop, PCU, module and 

block to help you understand where the output reference is  needed. 

 

5. The FC source is now reported for tagged but not exception-reported message to make them 

easier to understand. 

 

6. PV/SIG:S now gets live loop data. 

 

7. Conductor NT has problems with trailing space in file name, so we now report all graphics 

files with spaces in the name.   

 

8. Lifecycle status is now used in our Conductor NT, Process Portal B and Composer processing. 

 

9. User fonts are now preserved so diagrams are readable. 

 

10. Logical OR operator support has been implemented. 

 

11. Initial support for Conductor 5.0 has been added. 

 

12. PPB and OPC tags are now supported in DBDOC. 
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13. We have corrected handling of Spec 4 for Function Code 242. 

 

14. The capability to view the following function codes as a dynamic bar has been added:  21, 22, 

23, 27, 28, 30, 47, 70, 79, 80, 132, 158, 182, 216 and 222. 

 

15. If building graphics, the "Unused on Primary Display" error message now actually cites the 

primary display name. 

 

16. When building Conductor NT and/or PPB graphics, if you forget to specify a colordef.dat 

and/or a fontdef.dat file, we will now use some default color and font data so that your 

graphics will at least appear in your M14. 

 

17. FDF file formats are now supported. 

 

18. Blocks imported from external sources that we report as "No Source Config" are now tagged 

with the phrase "Unconfigured source".  Search for this phrase in your M14 in Hyperview and 

you will be presented with list of all of your unconfigured blocks. 

 

19. In Composer systems, if an OREF does not exist, we will now tag the source with the phrase 

"No OREF". Searching for the phrase "No OREF" shows every place in your system where an 

output reference is needed. 

Taglist_exporter: 

 

1. DAANG Blocks now have HALRM handled correctly.  This corrects a problem that 

affected people using the DBDOC tag export for PI systems. 

Hyperview: 

 

2. The feature "Go To Output" has been implemented.  After you have used the "Go To 

Source" feature, you can then double-click on the source or select "Go To Output" from 

the pop-up menu to return to the block that you just came from. 

3. A fix has gone in to correct the printing done by "Management of Change" from the 

BuildPlus window. 

4. The size of the text that appears in annotations can now be changed to suit your needs. 

5. You may now modify the color of your text and live loop annotations, as well as any 

manual live loop boxes that you spawn. 

6. In the pop-up menu, you now have the option to set the zoom percentage that you want the 

drawing to be zoomed to.  Minimum and maximum zoom factors are taken into 

consideration so that you cannot zoom outside of  bounds. 

7. If you have a mouse that has a scroll wheel, you can now use it in conjunction with the 

"CTRL" key on your keyboard to scroll pages left and right. 

8. In a multi-IP Address and/or multi-loop live monitoring setup, Hyperview will now do 

some checking to automatically detect which connections are active.  The Hyperview user 
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will not have to know which live loop setups work as Hyperview will automatically detect 

it for him. 

9. Specs are now displayed in their own stand-alone windows which can be moved to 

different locations on your sheets if they are obscuring other information that you want to 

see.   The windows are rubberbanded to their original spots so that you can see where they 

originated from. 

10. There is a new interface to manage both text and live loop annotations.  Previously, live 

loop annotations could not be found unless they were bookmarked; now you can easily 

find them in our "Manage Annotations" tool. 

11. Handling has been added for the case where multiple Hyperviews are viewing the same 

M14 file - text and live loop annnotations, bookmarks, etc. can now be added in any copy 

of Hyperview without wiping out additions in the other open copies. 

12. When viewing an analog value as a dynamic bar, the actual value will be shown in a 

tooltip if you put your mouse on the bar. 

13. The Hyperview "red boxes" problem has been fixed - this is where Hyperview would 

display red boxes even though it appeared the CIUMon communications were good.  The 

only way to fix this previously was to close down Hyperview and restart it.  We have 

added in handling which should take care of this problem and allow for the live data to be 

displayed without closing and restarting. 

14. You can now print just the FC 1 graph in Hyperview without the underlying CAD behind 

it.  The graph will be printed at full-page  size. 

15. All FC 1 graphs on a sheet can be opened at one time by selecting the "Graph | All 

Functions..." from the pop-up menu. 

16. Live loop annotations can be displayed as bar graphs. 

17. The "Go to Source" feature has been improved. 

Decomposer: 

 

1.  Error messages have been improved to provide more information, such as 

    loop, PCU, Module and Block, so that it is easier for you to track down 

    potential problems. 

2.  Chinese characters are now replaced by a "?". 

3.  Our Composer processing now looks at the Lifecycle status and handles tags 

    appropriately based on the data from this field. 

4.  Source and destination document names have been added to off-module 

    connections. 

5.  Function codes 22, 23 and 201 are now being handled correctly. 

 

 

Database Utilities: 

 

1.  DBFMT has been modified so that trailing spaces are compressed in our 

    database presentation. 

2.  DBOPCCSV.exe has been created to handle .CSV files that are extracted from 
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    OPC-90.  These files can now be built into your final M14 by looking for 

    and selecting them in your "Database Specification" search in BuildPlus. 

3.  DBXML.exe has been upgraded.  It now relies on the file libexpat.dll. 

 

 

CIULink: 

 

1.  Create an export file that allows you to import the tags being monitored in 

    CIULink on one machine onto a different computer. 

2.  CIUlink can now automatically generate a file which can be imported into 

    Microsoft Excel to set up live data monitoring via DDE. 

3.  The tagname is now recorded in the log created when monitoring in Export view. 

4.  Horizontal scrolling has been fixed in the Debug view. 

 

 

CIUMon: 

 

1.  CIUMon keeps track of the incoming requests and compresses them so that  

    duplicate requests are not sent out to the CIU, thus reducing the load.   

    CIUMon will send out the information to all those who requested the data  

    when it receives a response back from the CIU. 

2.  The "F1" key now launches the help file. 

3.  Spec formatting for the Harmony I/O Function codes (FC 221 to 229) has 

    been corrected. 

4.  Handling for the NCIU01 type of CIU has been added. 

5.  Changes have gone in to the correct the reporting of IP fragments by some 

    firewalls.  We now correctly handle the sending of the UDP packets between 

    CIUMon and Hyperview/CIULink. 

6.  The viewing of tracked user statistics has been improved.  On both the  

    detailed and summary dialogs there will an "Update" button which will allow 

    you to get the most current statistics without having to close down  

    and reopen the dialog.  As well, you can switch between the two views 

    easily with the "Switch to Details (Summary)" button that has been added. 

7.  The requestor's IP Address is now appended to the end of the response 

    message being sent out by CIUMon so that the user knows where each set of 

    data is going. 

8.  A new program, CIUMonController, has been created to allow the user 

    to change particular options (such as turning on logging) in service 

    copies of CIUMon.  This is particulary useful when a CIUMon service is 

    not interacting with the desktop. 

9.  Handling has been added to work with the Hyperview automatic live loop 

    connection detection. 

10. CIUMon has had a significant "memory leak" fixed.  The effect was to use 
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    a lot of virtual memory when CIUMon ran for weeks, which only was recovered 

    when CIUMon was stopped or the computer rebooted. 

 

 

Virtual Port Setup: 

 

1.  A new version of the VSP files has been implemented to take advantage of 

    the new features and fixes.  Upon the initial running of VirtualPortSetup 

    with these new files in place, you will be asked to reboot your machine in 

    order for the files and registry to be completely updated. 

2.  You will now be allowed to create more than 9 VSPs on your machine and 

    create up to 15 virtual connections.  The port numbers that will be available 

    range from COM1 through to COM128. 

3.  The "Physical-to-Virtual Connections" option has been disabled until we can 

    do more research into how these connections work.     

 

 

Data Files: 

 

1.  Errfilter.cfg has been modified to handle new error messages generated by 

    hyperlink. 

2.  Filetypes.txt and Param.txt have been improved. 

3.  Output.txt has been corrected for its descriptions for Function code 149. 

4.  Bitmaps are now included in the search for PPB/Operate IT/Conductor NT 

    submodels and will be built if any are found. 
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Version 9.81 −−−− June 2, 2005 
 

Hyperlink: 

 

1.  The displaying of dynamic bars with live loop monitoring has been fixed. 

 

 

CIUMon: 

 

1.  CIUMon has been modified to handle the text specs found in function codes 

    221 through 229. 

 

 

CIULink: 

 

1.  Missing code has been patched in to handle the IP_BLOCKED messages sent 

    back from CIUMon.  This is a concern only if a particular IP Address has 

    been marked as blocked in the CIUMon options. 
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Version 9.80 −−−− April 25, 2005 
 

Wizard: 

 

1. When BuildPlus cannot suggest a search path for a particular filetype, the search path in 

Wizard is left blank instead of being filled in with the default "C:\".  This prevents the 

searching of the whole hard drive if the user fails to remove the default when browsing for the 

correct location as the new path will get automatically appended to the existing search path. 

2. The option to select DGN files to include in your project has been added. When the "Apply" 

button is pressed to change search directories to match that of the main search path, the 

changes will not be applied to any filetype that refers to the special "Decomposer" directories 

created in  the project directory for Composer projects.  This is to safeguard against the 

accidental override of these preset search paths for particular types of files and to ensure that 

the user will find the correct files to build in to the project. 

3. For the xdc files and colordef.dat and fontdef.dat files, the selection has been automated more 

if only a single folder-single file is found for the listed filetype.  The file will be automatically 

chosen to be included in the build so that the user does not have to do any extra "clicking". 

 

BuildPlus: 

 

1.  The Database-Graphics Associations have been improved to allow for mutliple 

    associations to be done for global graphics paths.  This allows the user 

    to build the graphics against multiple different consoles. 

2.  When the user is running with the programs and files from the Overrides 

    directory, this setting will be indicated in the error files so that the 

    user knows that he is not building with the original build kit. 

3.  DBSpec.vbs is now triggered to run for all builds. 

4.  There is now a "Recent Projects" option under the "File" menu.  This allows 

    you to easily switch between the current projects that you are working on. 

5.  A "Refresh" button has been added to the toolbar so that the menus, toolbar 

    button states and project settings can be updated with a push of a button. 

    This is particularly useful if you are running multiple copies of BuildPlus 

    at the same time. 

6.  BuildPlus now ensures that the extracted databases all have unique names 

    to avoid conflicts with later processing in DBSpec.  As well, any extracted 

    database that contains a '.' in their name will have it replaced with an '_'. 

7.  If Batch files are being included in a build and there are multiple UNT files 

    being associated to one B90 file, then BuildPlus will create a clone 

    of these files in the project directory in the "BATCH" subfolder.  As the 

    same batch file gets built multiple times into the M14 because of the multiple 

    UNT files, this ensures that each instance of the B90 has a unique URL 

    reference in the M14. 

8.  The build logs for the project have been moved to the "LOGS" folder located 

    in the project directory.  The Management of Change files have also been 

    moved into their own "MOC" folder in the project directory. 
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9.  Ladder modules are now included in the "Duplicate Module Header" resolution 

    as it would wrong to build the same module for both Ladder and CAD.  This  

    will force the user to choose the correct module to include in their build. 

    Additionally, general improvements to the "Duplicate Module Header" dialog  

    have been made to make the module selections easier. 

10. When starting a project from the "Build" button, BuildPlus will now check to 

    see if new SODG graphics folders have been added to the original search path 

    for graphics (specified in Wizard).  If any are found, they will be presented 

    to the user to allow him to choose whether or not he wants to include them in 

    the project at build time.  This functions in much the same way as the 

    "Auto-Detect New Module Headers" feature. 

11. BuldPlus now writes a summary of the types of filtered errors from the hyperlink 

    run and the number encountered of each type into the DBDOC.ERR, DBDOC_RESIDUAL.ERR 

    and DBDOC_SUMMARY.ERR files for ease of reference. 

12. BuildPlus will check to see if an Access database is created by Access 97 before 

    carrying out any database processing as our database utilities do not handle Access 

    2000.  If the database does not meet our Access requirement then the user will be 

    informed of this and it will not be included in the build. 

13. The detection of a different version of MCRSize.dbf will now trigger a full decomposer 

    run for all Composer projects. 

14. The "Decomposer Directory Source" window is now an independent window that can be 

    kept open while you perform other operations in BuildPlus.  This allows you to  

    refer to it without having to memorize or print out the information if you need it 

    to make the correct choices in some other project option. 

 

 

Hyperlink: 

 

1.  Code has been implemented in order to facilitate the launching of the Graphics 

    Cross-References in its own separate floating window.  This change is made in 

    conjunction with changes made in Hyperview to accomodate this new feature. (See 

    Hyperview #1) 

2.  Titles are now limited to 128 characters in order for Mediaview Compiler to accept 

    them. 

3.  Sizing of data for continuous live loop monitoring on Conductor NT graphics has been 

    corrected so that it is consistent. 

4.  Hyperlink will check for incorrectly set spec 20 on FC 177 as this spec means there 

    will not be an alarm when there possibly should be.  A message will be outputted to 

    warn the user of this condition.  The message is suppressed for multilevel alarming 

    if none of the delta values are valid. 

5.  Overlapping External Block definitions are now handled.  These changes are made in 

    conjunction with changes in Hyperview in order to accomodate this feature.  (See 

    Hyperview #2) 

6.  Hyperlink generates three unused tag reports - Unused_tags.txt, Unused-alarm_tags.txt 

    and Unused-unconfigured_tags.txt.  The tags are separated into different 

    categories for easier analysis by the user.  Note: The Unused-alarm_tags.txt takes 
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    into account the alarm limits before the tag is reported as an alarm tag; otherwise 

    the tag will just be reported in Unused_tags.txt. 

7.  Various fixes have gone in to handle FC 156 and FC 136. 

8.  Tags that are not on their primary display are now being reported. 

9.  Hyperlink will report tagnames which contain a '/' in them if they are PCView as such 

    tags are illegal in PCView. 

10. Support has been added to implement the "View As Dynamic Bar" feature in Hyperview. 

    (See Hyperview #4) 

11. New support has been added to handle the processing of DGN files. 

12. Support for AutoCAD 2004 has been added. 

13. A new directive to strip off prefixes on tags in Wonderware databases has been added. 

    In the "Custom Edits" in BuildPlus, add the directive "wonderware_prefix" followed by 

    the prefix(es) that should be stripped off.  This will allow for the Wonderware tags 

    to sort with the Bailey tags in the tagmap presented in Hyperview. 

14. The orientation of vertical text on Conductor NT graphics has been fixed.  This fix 

    is good on Windows NT platforms but will not work on Windows 9X. 

15. Trend configuration and historical database tags are now getting linked to correctly 

    in the xdcdump file. 

16. There are improvements in drawing Conductor NT graphics. 

17. Additional support for new tagatoms has been added. 

18. The number of rung blocks in ladder files reported in our summary files 

    has been corrected. 

19. Conductor NT graphics can now be called up by number. 

 

 

Hyperview: 

 

1.  The Graphics Cross-Reference are now presented in its own separate floating window -  

    allowing the user to position the window where he wants and to keep all of the 

    cross-references in front of him while moving between different graphics in the M14. 

2.  Overlapping External Block definitions are now handled.  For example, you can have 

    Loop 3 declared as external and able to fetch live data and then specify Loop 3 

    PCU 4 Module 2-All Blocks as not being accessible (these specifications are 

    declared in BuildPlus).  Hyperview will handle the blocks appropriately, sending 

    out data requests or suppressing them, as specified by where they are defined  

    in the range.  These changes are made in conjunction with those in Hyperlink 

    in order to accomodate this. 

3.  You can now search for tags in the "Define Live Loop Annotation" dialog with  

    psuedotags, scanned tags or other aliases. 

4.  Display any data as a dynamic bar graph whether it is binary or analog.  Choose 

    "View As Dynamic Bar" from the pop-up menu, where available, to show the value, 

    the LPMB information and the span of the data value. 

5.  The graphing of Function Code 1 has been corrected where the last point was getting 

    missed. 

6.  Live loop monitoring boxes on ladder files have been fixed so that they are the 

    correct size. 
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7.  The new command line switch MonitorOff allows the user to specify that live loop 

    monitoring be turned off after a given interval (in minutes). 

8.  The "Manage Bookmarks" dialog is now sizable and its settings retained between runs 

    of Hyperview. 

9.  Support for DGN files has been added (in conjunction with Hyperlink). 

10. Bitmaps on Conductor NT graphics now get printed when the graphic is printed. 

 

 

Decomposer: 

 

1.  Work has been put in in order to enable the faciliation of the floating cross- 

    reference in Hyperview.  (See Hyperview #???????) 

2.  Decomposer translates the EBY name into the appropriate user name or CAD name for 

    easier reference by the user. 

3.  A problem where Decomposer "got lost parsing" a client CLD file has been resolved. 

4.  Corrected macro size for FC 51. 

5.  The handling of FC 21, 22 and 23 spec position has been corrected. 

6.  SYMEMPTY.DBF has been modified to handle up to 64 character long names.  This gets 

    rid of many of the "Unknown shape" errors being reported previously. 

 

 

Database Utilities: 

 

1.  Our visual basic scripts have been modified to set the locale to "en-us" in order 

    for processing to occur correctly when operating on systems with differently set 

    locales. 

2.  Tags that are specified Module 0,00,00 Block 0000 are not included in our TD_NOLIST 

    when it is extracted with our DBSynth program (for FoxPro databases). 

3.  New database templates have been included for our TTX2DBF processing (for TTG,TTR  

    databases). 

 

 

CIULink: 

 

1.  Save the users view preference to the registry so that CIULink opens up to that 

    view on start-up. 

2.  There is a new option under "Tag Monitoring" that allows you to specify the number 

    of significant digits that get displayed in Export view.  This allows you to display 

    the data in a format that makes the most sense to you. 

3.  A fix has been added to correct the display when monitoring in CIULink and Excel at 

    the same time. 

4.  The interface to set the frequency at which data will be requested has been improved. 

 

 

CIUMon: 
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1.  A new option - "Modify Service Properties" - has been added for the CIUMon service 

    handling.  This provides the user with an interface with which they can modify the 

    settings of their CIUMon services without actually having to access the Service 

    Control Manager. 

2.  There is now an option of adding on a watcher service to your regular CIUMon service. 

    This watcher service will continually check to make sure that the CIUMon service is 

    running and if it is not, restart it automatically for you. 

3.  CIUMon gives the user the option of keeping track of user statistics.  With this 

    option turned on (located on the "Logging" page of the CIUMon options), CIUMon will  

    keep track of who is requesting data, what data is getting requested, the number of   

    requests and the first and last time of the requests.  You can then view these 

    statistics by selecting one of the new "Communication Statistics" options available 

    under "Options". 

4.  There is a new option to display the IP Address of the requestor; this will be appended 

    to the end of each request.  This gives the DBDOC Administrator a quick check of 

    who is requesting data.  This option cab be turned on or off on the "Logging" options 

    page. 

5.  Contextual help has been added to all dialog boxes. 

6.  A fix has been added to correct the problem where some clients would see the VSP 

    splashscreen appear continuously when CIUMon was started up.  This problem was due to 

    a missing dll on the system required to enumerate to running processes; a message box 

    will now appear to report this condition and the "flashing" splashscreen should no 

    longer occur. 

7.  A tool has been created, VSPCleanup.exe, that will wholesale remove all traces of  

    virtual serial ports on a computer when there appears to be a problem removing them 

    through the regular VirtualPortSetup application.  This program is located in the 

    "Programs" folder of your installation location. 

8.  General clean-up of memory leaks. 

 

 

DataFiles: 

 

1.  Errfilter.cfg has been modified to handle new messages generated by Hyperlink. 

2.  Filetypes.txt has been changed to: 

    (a) Include ladder modules in Duplicate MHD resolution dialog 

    (b) support DGN files 

    (c) automatically select all folders in SODG graphics, B90, AutoCAD, Microstation, 

        DXF, RTF and Other files 

3.  Param.txt has been modified to: 

    (a) support DGN files 

    (b) support new appearance/categorization of filetypes on initial panel of Wizard 

4.  Output.txt has been modified to correct a problem on FC 136 (Output N+3 was specified 

    as binary, not real). 
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Version 9.70 −−−− October 22, 2004 
 

Wizard: 

 

1.  "Back" button response during the search phase has been improved. 

2.  The ability to select folders with a "." in the name has been enabled. 

3.  A "Disable" checkbox has been added to the "Root Directory" in the main path 

    specification panel.  This checkbox will be set and the Root Directory combo  

    box will be grayed out if the user has specified any database(s) in the 

    BuildPlus Project Specifiction dialog.  This is to prevent the inadvertent 

    application of the general root directory to the "calculated" locations of the 

    user's source files (such as Decomposer1 subfolders, etc.).  It is at the  

    user's discretion that this checkbox can be unchecked and the prescribed file 

    locations can be overridden with the Root Directory suggestion. 

4.  "Browse and Add" - Wizard now behaves like the BuildPlus Project Specification 

    browse where new paths are added onto the existing list in the edit box.  This 

    means that you no longer need to go through the copy-browse-paste sequence in 

    order to retain any previously entered paths in the edit box after doing a browse. 

5.  Concatenated paths now appear in the combo box lists. 

6.  The folder containing ANALOG1.DY for Bailey Standard Symbols is automatically 

    selected. 

7.  All user symbol psths (not containing ANALOG1.DY) are automatically selected 

    for SODG processing. 

 

 

BuildPlus: 

 

1.  Support for CITECT and .TTG/.TTR databases has been added.  You can now specify 

    that CITECT and TTG/TTR databases be included in your project - simply look for 

    them under the "Generic" database category in the "Database Specification" 

    dialog. 

2.  BuildPlus support has been added for our taglist_exporter application.  A new  

    dialog box will appear where you can choose which databases you want to have 

    taglist_exporter run on.  These database choices are also shown on the "Project 

    Options | Taglist Exporter" page.  Chosen databases will be run through our 

    taglist_exporter application which will generate an appropriately named dbf that 

    will contain a global taglist. 

3.  On existing projects, when a user starts the build from the "GO" button, pre- 

    existing project information is retained rather then getting cleared. 

4.  The "link_slave_references" directive has been added to the list of default 

    suggestions on the "Custom Edit" page of the "Project Options".  For new projects 

    this directive will be automatically enabled; if you wish to take advantage of 

    this feature in existing projects simply go to the "Custom Edit" page, select 

    it from the default list and click the "Insert" then "OK" buttons.  Enabling 

    this feature allows the creation of a class of tags from the reference text on 
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    slave function blocks. 

5.  A new feature to export and import a project has been implemented in BuildPlus. 

    These options are available under the "Tools" menu.  When you choose to export 

    a project BuildPlus will create a .BPI file that it can use to import the project 

    on a different machine (or same machine, different location).  The file contains 

    information regarding the registry settings for the current project, selections 

    from the Configuration Wizard and project .RAW file information so that there 

    should not be any need to specify anything when the project is imported.  This 

    option is best used in conjunction with a project that has used UNC naming 

    conventions when specifying source file locations.  You can then utilize the 

    Import Project option to recreate a project from a BuildPlus generated .bpi file. 

    To find out more about these new options, please look at our help documentation 

    under "BuildPlus | BuildPlus Menus and ToolBars | Tools" and select either 

    "Export Project" or "Import Project". 

6.  The ability to rename, clone or move a project has been implemented.  You can 

    access the first two options two ways.  Launch the Database Specification dialog 

    (press the "GO" button) and change the name that appears - BuildPlus will bring 

    up a dialog to see whether you want to rename your project, clone your project 

    or retain your old project name.  The other way to get to these new options is 

    from the "Tools" menu where you can choose to "Rename Current Project..." or 

    "Clone Current Project...".  Both of these options will bring up a dialog box 

    which lets you enter in a new name for your project.  To move a project, you can 

    choose the "Move Project..." option from under the "Tools" menu where you can then 

    choose the new build root and, optionally, new project name that your current 

    project should be moved to.  To read more about these new options, please look 

    at our help documentation under "BuildPlus | BuildPlus Menus and ToolBars | 

    Tools". 

7.  For Composer projects, the CLDNames.map and DisplayNames.txt files are now named 

    uniquely.  The CLDNames.map name will be based on the EBP file name and 

    DisplayNames.txt will use the description found in the console.cfg file as part 

    of its name.  This fixes the multiple-cldnames.map-files-with-same-name-in-one- 

    chapter problem. 

8.  A general "clean up" of resource and memory leaks. 

9.  The Management of Change tool to display and print differences between builds 

    has been changed.  On the "Management of Change" page of the "Project Options" 

    the treeview of changes does not automatically appear as part of the page  

    any longer.  You can choose to see/print the changes by now pressing the "Show 

    Changes" button at the bottom of the page which will trigger BuildPlus to 

    generate the treeview of changes in a separate dialog.  This will benefit those 

    who are not interested in seeing/printing changes at the moment as the treeview 

    of changes may take a few minutes for BuildPlus to set up depending on the number 

    of builds compared and differences found; this way the user will have access 

    right away to the Management of Change options. 

10. When rebuilding Composer projects, old versions of user and standard symbols 

    and global graphics are deleted from our extracted set of files so that they 

    will not be included in the current build. 
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11. The method of defining blocks with external sources has been improved.  Users 

    now have the ability to define a whole Module, PCU or Loop with external sources 

    without having to define the specifics for each Loop, PCU, Module and Block field 

    on the "Define Blocks with External Sources" page of the "Project Options". 

12. Initial support for a single XDC dump has gone in. 

13. The DAO SDK is required to be installed now for all CAD/LAD and PI.XLS builds. 

    If BuildPlus detects that DAO is not installed, it will automatically prompt you 

    and ask if you wish to install it at that time.  For the most part, you should 

    choose to do the installation to ensure that your build will complete 

    successfully. 

14. More robust handling has been added to handle the case where the build computer 

    does not have access to the computer with the source database files after the 

    build has started.  If you are doing a manual build and a source file was not 

    found then BuildPlus will bring up a warning dialog box which allows you the 

    time to logon onto the remote computer (or insert the CD into the drive) and 

    try again or to stop the build. 

15. If a new version of our DBType program is detected, then all generic DBF type  

    databases will be rerun through it so as to reclassify any databases which may 

    now be handled by a new type of processing we have implemented. 

16. A list of new tags that were found to have been added since the previous build 

    is now created by BuildPlus and listed in the file new_tags.txt located in the 

    "Exports" folder of the project directory. 

17. The functionality of the "Symbols-to-Graphics Association" dialog has been 

    improved when launched during an in-line build.  The selected set of symbol paths 

    is retained when moving on to the next new path. 

18. When BuildPlus performs its missing and mismatched program/file check, it now  

    performs an additional CRC check to make sure that the installation did not in 

    some way corrupt the file.  This error will be clearly indicated in the program 

    summary (at the end of DBDOC.err and DBDOC_Summary.err or contained in 

    DBDOC_Components.txt) if a CRC mismatch was detected. 

19. The process priority level of non-GUI programs and the MediaView compiler is now 

    set to the "Below Normal" by default for those who run BuildPlus for the first 

    time.  This option is located in the "BuildPlus Options" if you wish to change 

    it. 

20. The "Project Settings and Selections" dialog is now resizable.  The settings 

    are saved so that the next time the dialog is launched it will open up to the 

    last used dimensions so that you do not have to continually resize the dialog 

    to suit your preferences. 

21. All log and system information files are now placed in the Logs folder (sibling 

    to the Programs folder of your installation directory).  These files include the 

    logs created during a buildall run and DBDOC_Components.txt generated from under 

    BuildPlus's "Tools" menu. 

22. The error.zip (or error.tgz) file is now located in the ERROR_FILES folder of 

    the project directory. 

23. The option to the automatically create the error.tgz at the completion of a 

    build has been added to the "BuildPlus Options".  By default, this option is 
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    check when BuildPlus is run for the first time with this option included. 

24. The ciumon  settings are now correctly reported in the error files for the user's 

    information and review. 

25. The option to launch Hyperview without having a current project open has been 

    added under the "Tools" menu. 

26. A new option to go the GMCL help website has been added under the "Help" menu. 

27. The obsolete option "Create Desktop M14 Shortcuts" in the "BuildPlus Options" 

    has been removed. 

 

 

Hyperlink: 

 

1.  CITECT console databases are now supported. 

2.  Hyperlink handling has been added to put in the functionality of displaying 

    live loop analog values as bar graphs when live loop monitoring is turned on in 

    Hyperview. 

3.  Support for bitmaps as documented submodels for Conductor NT graphics has been 

    added. 

4.  CLIF functions are now fully supported.  These are a custom set of function codes 

    that use INFI-90 function code numbers with custom implementation. 

5.  Hyperlink now checks for duplicate slave addresses.  This is preliminary work to 

    detect slave configuration problems. 

6.  Attributes are only displayed above exception-reported blocks.  If a tag refers 

    to a block that cannot work, we do not show the bogus tag name above it. 

7.  FC 36 test is suppressed if there are no inputs and no outputs.  8-input OR blocks 

    that are unwired do not need to generate a message. 

8.  The IREF and OREF Text is used as scanned tags if no other information is available. 

    This new feature, triggered by the link_slave_references directive in the custom 

    edit box found in BuildPlus, creates pseudotags out of input and output references. 

    This can improve linking to AutoCAD and MicroStation drawings and other tabular 

    data. 

9.  XDCdump "block" information is now supported.  This support has been added for 

    Conductor NT xdcdump "block" information that defines a set of history tags as 

    being in one block of data that can be fetched. 

10. Direct support for single xdc dump files has been added.  This will handle all 

    the xdc file linking and checking using a single file generated by a command 

    line like "xdcdump all.xdc" to make support of Conductor NT systems easier. 

11. A fix has been implemented to correct a problem where the tags were not showing 

    up in the audit window on CAD sheets. 

12. The PCU Map support has been enhanced to show all the blocks that are imported  

    from each PCU and all those that are exported from it. 

13. Hyperlink will report the number of PCUs and Modules actually configured.  This 

    feature will help us guide people who are contemplating adding Serial Port  

    Modules for DBDOC data support. 

14. FC 1 F(x) functions that are discontinuous are reported for inspection. 

15. The limits for FC 68 is checked.  REMSET blocks that have a value outside the 
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    configured limits are reported. 

16. Improvements in defining blocks with external sources have been implemented.   

    This works with the latest BuildPlus - refer to #11 in the BuildPlus section of 

    the release notes. 

17. A diagnostic file has been created for F(x) messages.  The new file, FC001.txt, 

    will be created when there are out of order X coordinates, adapted coordinates 

    or discontinuous functions to make it easy for us to explain the messages to you. 

18. The flat function F(x) messages have been enhanced to show the constant value 

    in the message. 

19. Alarm Group Zero handling has been corrected.  The case where a tag is defined 

    in more than one database but is in a non-zero alarm group in only one of them 

    is now being handled properly.  We assume that it will alarm in the console 

    using the database where the alarm group is not zero. 

20. Hyperlink will now generate a message if the tagname and the tag index in a  

    graphics element do not match.  This for support of old MCS/OIS SODG Graphics. 

21. Hyperlink will report modules that have a problem if there is no input attached 

    to some blocks. 

22. We have corrected checking of the input type for FC 220. 

23. Hyperlink checks for duplicated slave channels and now accepts remote I/O functions 

    that can duplicate the apparent slave channel. 

24. Hyperlink link will translate S4 set to 0 on DAANGI/L and DADIGI/L blocks to 

    mean "this loop". 

25. When databases contain over 32767 records, hyperlink will create a new file RTF 

    file to break up the entries so that we do not encounter problems later with the 

    Mediaview compiler limits. 

26. Hyperlink will generate a file named Unused_symbols.txt that will give you a list 

    of the symbols that are not used in any of the graphics that you built.  Popups  

    will be of special interest as they are difficult to keep track of. 

27. TAGTYPEs SPARE and OTHER are now created by Hyperlink.  These can be used, for 

    example, for artificial tags created from RTU files. 

28. SODG graphics processing has been modified to use the file length information 

    included in the header of a DR file, thus preventing non-local exits introduced 

    by graphics that have record fragments after the last valid record. 

29. Two new databases are generated in the Exports folder of the project directory - 

    TAG-GRAPHICS.DBF and GRAPHICS-TAGS.DBF.  These databases will contain information 

    about which tags are in which graphics and which graphics contain which tag. 

30. Ring (Loop), PCU  and Module information stated explicitly in B90 files will  

    override any other LPM specification for that particular line. 

31. B90 comment colors in the M14 file have been darkened to make them more visible. 

 

 

Hyperview: 

 

1.  Live loop analog values can now be displayed as bar graphs for quick analysis. 

2.  The new feature "Recent M14 Files" has been added under the "File" menu which 

    will list the last 4 M14 files that were viewed in Hyperview.  You can use this 
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    option to quickly navigate between the last few M14 files that were opened. 

3.  The Table of Contents can be sized down completely so that the Topic pane takes 

    up the full Hyperview window.  You can: (a) manually drag the splitter bar until 

    the TOC pane disappears, (b) choose the "Full Screen" option from under the "View" 

    menu or (c) press the "F" key on your keyboard.  The latter two will allow you 

    to toggle between having both panes displayed and just the Topic pane. 

4.  Reverse video on the Block Map has been suppressed if Vegas Lights have been 

    turned on.  This is due to the fact that color is meaningful on the Block Map. 

    If Vegas Lights are turned off then the reverse video will be in effect. 

5.  External blocks with no source did not function correctly on text files when  

    live loop monitoring was turned on or with live loop annotations in previous 

    versions.  This problem has now been fixed. 

6.  The live loop annotations file (.ahb) is now updated after a live loop annotation 

    is created as opposed to at the end of the Hyperview run.  This is for the  

    situation where Hyperview exits unexpectedly in which case the newly entered 

    annotations would not be saved for the next run. 

7.  A fix has been put to correct where Hyperview would crash on Windows 98 if the 

    color depth was set very low. 

8.  The ability to refine a full text search has been added to the search results 

    dialog.  Click the "Refine Search" button at the bottom right hand corner of  

    the dialog to bring up the search dialog again, filled in with your previous 

    settings for easier modification. 

9.  Inconsistent live loop monitoring behaviour on Conductor NT graphics has been 

    resolved.  The symptom would be that not all live loop hotspots would appear when 

    live loop monitoring was turned on and that turning off and on the monitoring 

    could result in different hotspots showing up each time. 

10. A problem where using the snapshot button did not always get data when certain 

    steps were followed has been resolved. 

11. The problem with rung blocks continuing to monitor after live loop monitoring 

    has been turned off has been rectified.  As well, unpredictable behaviour that 

    was discovered when monitoring ladder files has been fixed. 

12. Live loop annotations are now minimized and maximized along with the text  

    annotations when the "Minimize All Annotations" and "Restore All Annotations" 

    options are selected from the pop-up menu.  As well, the minimized live loop 

    annotations will no longer continue to fetch live data until they are restored 

    thus reducing the load on the CIU. 

13. The live loop update interval now allows for fractional seconds to be entered, 

    up to 3 deciminal spots. 

14. When you hover over a database name in the Databases chapter in the index, the 

    data tip will show the database name and the source that it came from. 

15. In TreeView Table of Contents the external modules are now indicated in blue. 

16. When a search is performed and no search results are found, a dialog box will  

    appear reporting no matches were found.  It will have a "Don't show me this again" 

    checkbox that will allow you to suppress this message box from appearing again 

    when no search hits are encountered.  You can reset this option by checking the 

    "Reset to show all suppressed dialogs" option on the "View" page of the "Options". 
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17. When a bookmark is added via the keyboard shortcut, Ctrl-D, a message box will 

    now appear informing you that the bookmark was successfully added.  If you wish 

    to suppress this message box from appearing on subsequent additions, check the 

    "Don't show me this again" checkbox before clicking the "OK" button to dismiss  

    the dialog.  To reset this, check the "Reset to show all suppressed dialogs" on  

    the "View" page of the "Options". 

18. The command line argument /m1 (for Conductor graphics) and /dr, /dis (an alias 

    for the /dt argument) have been added. 

19. The command line switch /tag has been modified to bring up the CAD source in the 

    Topic pane in addition to the index panel in the Table of Contents pane.  If there 

    is no source, only the index panel will be called up with the Topic pane containing 

    the previous historical document. 

20. Switching from demo data to real live data has been fixed.  Previously, you 

    needed to restart Hyperview after removing your demo settings and entering in 

    your real live loop settings before you would actually get real live data. 

21. When "File | New Window" is used, the new Hyperview that is launched will adopt 

    the same command line switches as the first Hyperview.     

22. The option to change the stale data text color to white has been added.  This 

    is found in "Options | Color Scheme"; by default, the "Use White Text for Stale 

    Data" is checked. 

23. The "Mark Topics for Printing" interface has been improved.  The option to print 

    both general and annotated topics has been added. 

24. Creating an identically named bookmark is no longer permitted. 

25. It is now possible to open up Hyperview in TreeView Table of Contents mode.  The 

    view style is saved when Hyperview is closed so that the next time it is opened 

    the user does not have reset it to suit his preference. 

26. "Go to Block Map" has been added to the pop-up menu and will be enabled on any  

    CAD sheet.  If you choose this option while the mouse is on a specific block, 

    the topic pane will display the specific block map page and the TOC pane will 

    display the module block map page. 

27. Live loop logging formatting has been improved.  The options of "Log Specs"  

    and "Log only good quality values" have been added to allow the user to more 

    precisely define what is getting written to the Hyperview log (available on the 

    "Options | View" page). 

28. The validity of the live loop logging path (specified on the "View" page of the 

    "Options") is no longer checked if the option to log data is turned off. 

29. A link to the GMCL Help website has been added under the "Help" menu. 

30. If at some point you have chosen to "Reset Preferences to Defaults" and close 

    down Hyperview, Hyperview will automatically do a "Restore Preferences" before 

    exiting.  If Hyperview does not exit cleanly then the restore will be performed 

    when Hyperview is next opened up. 

 

 

Decomposer: 

 

1.  A wiring problem that Composer misses will be detected by DBDOC (FC 227 and 228 
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    S3 requirements). 

2.  A problem was discovered where not all SODG symbols were getting extracted in 

    Composer projects and has been resolved. 

 

 

Database Utilities: 

 

1.  A new database utility DBSpec.vbs has been created.  This will add links to the 

    various tag dbf files that we have made in spec.mdb.   

2.  The DBType application has been modified to detect CITECT console databases. 

3.  A new application taglist_exporter.exe has been created which will create a 

    master list of all tags in the system. 

 

 

CIULink: 

 

1.  A new feature to save, load and delete separate tag lists has been added.  This  

    allows you to switch quickly between lists of tags without having to manually  

    delete and re-enter the desired points each time you want to look at frequently 

    monitored, unrelated points.  These lists are saved so that they available to you 

    on subsequent runs. 

2.  A status bar has been added to the top of the CIULink window to inform the user 

    of the latest CIULink status.  The status bar will indicate the following: 

    (a) whether or not monitoring is turned on or off 

    (b) the frequency at which the updates are being done 

    (c) whether or not logging is turned on or off 

    (d) the size of the current log and the maximum size allowed 

    (e) the name of the log file 

3.  A monitoring problem on Windows 98 and NT was fixed where monitoring was blocked 

    for valid data points which did not have an assoiciated database entered in 

    for verification. 

4.  General "clean-up" of memory and resource leaks. 

5.  You can now limit the size of the log that is created by CIULink.  Choose "Set 

    Log Size Limit" from under the "Tag Monitoring" menu to specify the maximum  

    allowable size of the log. 

6.  CIULink settings and preferences that were previously stored in the CIULink.ini 

    file have now been converted to be stored in the registry. 

 

 

CIUMon: 

 

1.  The ability to add CIUMon as a service has been implemented.  This will allow you 

    to specify the launching of CIUMon with a certain configuration after the computer 

    has been rebooted without any manual intervention.  This will be of great 

    benefit to those users who have CIUMon running a remote central server - this  

    will guarantee that CIUMon will restart even if a person reboots the machine without 
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    any knowledge of CIUMon or DBDOC.  Multiple instances of a CIUMon service can be 

    added to handle more than one CIU on one computer (ie. multiple SPM02-type CIUs). 

    To read more about this new feature, look at our help file under "CIUMon |  

    CIUMon Toolbar and Options | Options... | CIUMon As A Service". 

2.  Handling of the SPM01 type CIU has been implemented. 

3.  Logs created by CIUMon and VirtualPortSetup are now placed in tbe Log folder of 

    the installation directory. 

 

 

DataFiles: 

 

1.  Errfilter.cfg has been modified to handle new messages generated by Hyperlink. 

2.  Filetypes.txt has been changed to: 

    (a) handle bitmaps as documented submodels 

    (b) select all user symbols by default in SODG processing 

    (c) update the contextual help in Wizard 

3.  Output.txt has been modified to correct a wording problem on FC 30. 

 

 

CrypKey: 

 

1.  The version of CrypKey has been upgraded to version 6.120.  This version 

    includes "clone buster" technology. 
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Version 9.61 −−−− May 17, 2004 
 

BuildPlus: 

 

1.  Correct issue for AutoCAD customers running programs out of the Overrides 

    directory.  The correct Adinit.dat file was not being properly replaced in 

    the run. 

 

Hyperlink: 

 

1.  Ensure trend database index is recorded for use in database search in  

    Hyperview. 

 

Hyperview: 

 

1.  Re-enable live loop monitoring on Function Code 1 graphs (timer identity 

    issue). 

2.  Correct multiple live loop snapshot monitoring problems.  Snapshot will 

    now reset on drawing change.  For both snapshot and continuous data 

    monitoring, reset timer interval whser first requests monitoring so 

    that data fetch begins almost immediately. 

 

CIUMon: 

 

1.  Fix CIUMon continuous retry on connect until succesful reply from the CIU. 

 

Data Files: 

 

1.  Errfilter.cfg has been modified to remove soft hyphens which were 

    inadvertently introduced in the document conversion. 
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Version 9.60 −−−− April 16, 2004 
 

Wizard: 

 

1.  Fixed infinite loop that prevented FINISH button from being enabled.  This 

    occurred in cases where a Conductor NT console was being built with its 

    source files on more than one machine. 

 

BuildPlus: 

 

1.  A new option has been added on the "Processing Options" tab in the  

    "Project Options" that allows the user to specify Hyperview's local port 

    range that is available to bind to in order to communicate with CIUMon 

    to fetch live data.  The port range information is written into the  

    baggage file from which Hyperview will read it and bind to the first 

    available port in the range.  This option is useful for those who must 

    communicate through a firewall and only have specific ports left open. 

2.  The "Define Blocks with External Sources" option has been modified to 

    make the definition of entire external PCU's and Modules easier.  As 

    well, there is an additional option which allows the user to specify  

    whether or not live data can be fetched for the particular external range 

    specified. 

3.  Multiple tag lists are now extracted out of Process Portal B Access 

    database if applicable. 

4.  Any files that are produced as a result of database processing on an 

    Access database are now placed in separate folders in the project 

    directory based on which database they were extracted from. 

5.  Multiple tag databases can now be associated with a particular SODG  

    graphics path to get the correct links built in.  Additionally, SODG 

    symbol paths have been added to the "Database-Graphics Association" 

    panel to allow for database associations. 

6.  A new option "Database Selections" has been added.  This allows the user 

    to exclude any databases that were extracted from .EBP, .MDB, .PTT and .XLS 

    databases that may not be pertinent to the current build. 

7.  There is an option to build in the current error files into the M14. This 

    is available in the "Advanced Options" on the "Processing Options" page. 

8.  BuildPlus will run the program DBSpec.vbs after each hyperlink run to 

    automatically generate an MDB with links to the exported FCnnn.DBF  

    files located in the "Exports" folder of the project directory. 

9.  Management of Change has been modified to only insert a summary line 

    when whole modules or databases have been added or removed from a build. 

    This will cut down on the size of the reports.  Additionally, the "moc" 

    qualifier has been added to the appropriate lines in the project files 

    to speed up the hyperlink processing of the Management of Change files. 

10. The file modification times have been removed from the M14 Table of 
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    Contents. 

11. The Sub-Process message window is now minimized during the Decomposer 

    and Hyperlink runs on laptops to minimize CPU time. 

12. For RTU processing, Loop, PCU, and Module information that can be parsed 

    from the filename or folder name will now be used. 

13. The "DBF and MDB Types Detected" dialog box that appeared after the  

    "Database Specification" dialogs has now been removed.  The database 

    categorizations can still be viewed in the "Project Options" on the "DBF 

    and MDB Types" tab.  Note: BuildPlus will try to categorize any 

    databases placed in the UNKNOWN category on each build/re-build so that any 

    database that may have been previously "broken" and subsequently fixed 

    will be automatically included in the new build. 

14. The .bmk, .ann and .hist files are no longer deleted for a project when 

    starting a build from GO. 

15. The "Rename" button (Cat-to-Dog) has been removed from the toolbar and  

    the option added under the "Tools" menu option. 

16. If there is only one M14 present for a project, BuildPlus will automatically 

    launch Hyperview at the completion of the build, open to that M14. 

17. The failure to launch Hyperview at the completion of a command line build 

    (one specified with the /build switch) on Windows 9X and NT 4.0 has 

    been fixed.  As well, at times, BuildPlus would crash on the launching 

    of Hyperview after a build from the command line with the /build switch - 

    this has also been fixed. 

18. New command line functionality has been added: /start, /fullcycle, 

    /exclude and /override.  The switches /start, /fullcycle and /exclude can 

    be used in conjunction with the /buildall switch.  /start allows the user 

    to specify which project to begin the buildall with; /fullcycle, specified 

    with the /start switch, tells BuildPlus that once it has reached the end 

    of the list of known projects, it should restart at the beginning and build 

    all projects until it hits that one specified with the /start switch.  The 

    /exclude switch allows for the exclusion of a full build root from the 

    buildall cycle.  /override tells BuildPlus to use the programs and 

    files that currently reside in the Overrides directory for the current run. 

19. If the Microsoft WinDiff tool has been installed on the computer, the 

    option "WinDiff Files" under the "Tools" menu will be enabled so that  

    WinDiff can be utilized to find differences between error files or folders. 

20. Database selection dialogs now show the number of records available in 

    each database. 

21. The option to stop a build after a pre-processing script failure (user set 

    option in "Processing Options") has been added.  One can also specify 

    the success code that should be returned from the script so that 

    BuildPlus can verify the success or failure of the script run. 

22. BuildPlus will automatically open up to the last opened project on 

    startup. 

23. On the "Processing Options" page in the "Project Options", there is now 

    an option available to specify a location to which to copy the final 
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    new M14.  This has been implemented to make it easier for the builder to 

    get the new M14 into the location where it can be accessed by all users. 

24. The CIUMon entries are now listed in DBDOC.ERR for ease of reference. 

25. The BuildPlus status bar has been modified to show the time and date 

    in the right-hand field. 

26. The PI Point Source defaults have been modified to include POINTSOURC,N. 

27. The Build Kit version information is now available in the "Help"-"About" 

    dialog box. 

 

 

Hyperlink: 

 

1.  Tags that are not on any graphic are reported in two files.  Tags which are 

    not found in Alarm Group and we think should alarm, but are not on any 

    graphic, are listed in the file Alarm_Tags.txt.  Unused tags are all other 

    tags that are not on any graphic and are reported in unused_tags.txt.  The 

    tagtype information is also included in this file. 

2.  Tag and data import checking has been implemented.  Tag and block inputs 

    are being checked for type and that they come from exception report blocks 

    as necessary. 

3.  Function code 1 F(x) support has been further improved to show discontinuities, 

    out of order coordinates and to make allowances for rounding problems. 

4.  Trend support for Process Portal B and PCView graphics has been improved. 

    We also export the trend tagname in the function code spec extraction and 

    show the trend tagname in Hyperview. 

5.  It is now reported if a gain value of zero is found that masks an input 

    value or constant. 

6.  A warning is now given for slaves that will trip on fault. 

7.  Support for Process Portal B graphics links through the object ids has 

    been implemented. 

8.  Unicode text files are now supported. 

9.  Wonderware database tag naming quirks have been accommodated. 

10. Rung block outputs in override are reported. 

11. Blocks 1 to 9 have a source if there is an EXEC block FC 81 and are checked 

    when imported. 

 

 

Hyperview: 

 

1.  The /save switch lets the user specify a directory where any files 

    generated by Hyperview will be saved.  The files affected are those 

    which are generated by the following operations: Audit Window File|Save, 

    Search Results File|Save, the "Gather live loop data in the following 

    path" option on the "View" tab and "Print to File". 

2.  Hyperview now binds to a particular local port to use in its communication with 

    CIUMon as opposed to using any available port.  The user can either author 
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    in a valid port range using BuildPlus or specify a range on the "Live 

    Loop Setup" panel in Hyperview.  The default range is 5000 to 5100 and 

    Hyperview will check for the validity of the port range entries and  

    report any errors encountered.  The port(s) which Hyperview has bound to 

    are shown in the setup list following each live loop setting. 

3.  The search features in Hyperview have been combined into a tabbed property 

    sheet format which can be launched with one search button on the 

    toolbar.  By hovering over the search button, the button will change to 

    display the last search type used - full text, database or keyword. 

4.  The links from function codes to the function code index have been 

    disabled.  This option, however, can be re-enabled by selecting 

    the "Function Code Hotspots" option under the "Highlight" menu.  Function 

    code specific help can still be accessed via the pop-up menu even if the 

    hotspots are turned off. 

5.  New functionality has been added to the pop-up menu: access to the block 

    map and "Set My Home Page". 

6.  Hyperview now displays text logic state descriptors in live loop for  

    digitals and device drivers. 

7.  Special handling has been added for quality hotspots. 

8.  The close box option (the 'X' in the upper right hand corner) has been 

    added to manual live loop windows. 

9.  The font size of the static live loop boxes is now authored into the M14 

    so that the display is in proportion to the drawing elements.  The live 

    loop font size changes made on the "View" page of the "Options" now only 

    apply to the live loop annotations and manual live loop boxes. 

10. Hyperview now permits live loop monitoring on hotspots that are marked 

    external (GPI interface provides access to the data that is actually 

    external to the Bailey system).  These external points are specified via  

    BuildPlus (see #2 under the BuildPlus section). 

11. The option to set the frequency at which Hyperview updates its live loop 

    information is now available.  Previously, Hyperview would ask CIUMon for 

    live loop data every second; the user can now configure this to be a 

    longer interval by either changing the option on the "View" tab of the 

    "Options" or setting the /update switch on the command line to the 

    desired interval (in seconds). 

12. An error message will appear now when an invalid tag name is entered in 

    the Live Loop Annotations option. 

13. Printing has been corrected to show specs on a printout when a sheet has 

    been added via the right-click pop-up menu. 

14. Support has been added to enable the use of the mouse scroll wheel. 

15. If the option to have search hits highlighted is turned on and a print 

    is requested, all drawing hits in the appropriate print region will be 

    highlighted on the printout. 

16. The F6 key can now be used to cycle through all open child windows 

    including: both topics, search results, topic title search, audit 

    window and help. 
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17. Support for bitmap records in Conductor NT graphics has been added. 

18. The option to abort a print job has been removed from Hyperview. 

19. The various print options available, such as adding a caption or 

    printing annotations, have been moved into the new "Advanced Print 

    Options" dialog. 

20. The user may now specify that the document path and filename be added 

    to the printout (available under the Advanced print options). 

21. An informational live loop message appears when the IP Address of the 

    current machine is blocked by CIUMon (see #3 in the CIUMon section for 

    more details). 

22. Improvements have been made to the "Print Annotated Topics" option.  The 

    annotated topics are now shown in the "Mark Topic for Printing" dialog in 

    a treeview listing where you can select or deselect the desired documents 

    for printing. 

23. Additional options are now available in the Audit Window under the "Save" 

    option.  The user can save the individual Block, Tag, Function, Reference 

    and Miscellaneous lists in various formats. 

24. Hyperview will now open the last opened M14 file if no parameter is given. 

25. Help can be brought up in the manual live loop windows with a right-click 

    to select it from the popup menu. 

26. When selecting "File" - "New" from the menu, a new copy of Hyperview will 

    be launched, open to the M14 file that is being currently viewed in the  

    copy of Hyperview that launched it. 

27. In SODG Graphics where references do not have a tag name, they will be  

    easily identified in the index with the phrase "(blank tagname)".  The 

    intent of this feature is to show the user where a link is being made 

    purely based on the index number. 

28. Support for the RCM block permissive, override and feedback has been 

    introduced. 

29. Links to documents with short names has been implemented. 

30. String specifications are now displayed as strings. 

31. A map of the colours used in AutoCAD and MicroStation sheets is now  

    created for user reference. 

32. Trend tags now show tagname attribute. 

33. The Kit Version is now displayed in the "Help" - "About" dialog. 

 

 

Decomposer: 

 

1.  SODG Symbol names are now in Composer and Conductor VMS. 

2.  Improvements have been made in extracting macros in Composer systems. 

3.  Handling has been added for 5-digit block numbers. 

4.  A fix has been implemented for a crash found in the CLD Parsing in 

    Decomposer on Composer 3.2. 
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Database Utilities: 

 

1.  The renumbering of blocks Module 0,0,0 Block 0 has been removed so that 

    the tag mismatch messages no longer appear due to this. 

2.  Case sensitive taglist/trendlist names are now handled. 

3.  New programs and files - DBPPB.vbs, Ppb,mdb and Ppb.dbf - are now part of 

    the DBDOC software kit to handle Process Portal B databases. 

4.  For Composer systems, a problem was encountered when working with a remote 

    read only copy of the LDB file causing a build failure.  This problem has 

    been remedied in our new versions of the various database programs and  

    the build should now continue on to completion. 

5.  The tagtype field has been increased to 15 characters from 9 to account 

    for newer, unknown tagtypes such as ANALOG1_O. 

 

 

CIUMon: 

 

1.  The saving of multiple configurations on one machine has now been 

    implemented in CIUMon.  This allows the user to easily switch between 

    configurations without having to discard any previous changes or to 

    run multiple copies of CIUMon on one machine if he has multiple CIU's  

    connected to his computer via multiple COM ports. 

2.  Handling has been added to respond to the "connstat" command from  

    Hyperview.  This has been implemented to allow Hyperview to check for  

    good communication status between CIUMon and the CIU.  (Note that this 

    feature has not been released yet in Hyperview.) 

3.  A new option to limit which IP Addresses can do live loop monitoring has 

    been added.  This option is accessible through the "CIUMon Settings..." 

    option under the "Options" menu.  On the "Approved IP Addresses" tab, 

    enter in the range of IP Addresses that are either approved or blocked 

    by CIUMon for live data gathering.  If no addresses are entered then  

    full monitoring is allowed for everyone.  A message will be sent back to 

    the requestor (either Hyperview or CIULink) if the IP Address is blocked 

    so that the person requesting live data is aware that his machine is not 

    currently approved for monitoring. 

4.  The virtual serial port functionality that was previously built into 

    CIUMon has been removed and built into its own application, VirtualPortSetup. 

    This has been done to accommodate running multiple copies of CIUMon on a  

    single machine.  The first copy of CIUMon which is started will launch  

    this application automatically and all subsequent copies of CIUMon will  

    reference the same copy of the VirtualPortSetup application.  (Note: this  

    only applies to machines running Windows NT). 

5.  The user can now enter in the number of virtual serial ports that can be 

    created at one time (up to 9). 

6.  The option to launch the RoviSys OPC90 Server Lite software upon CIUMon  

    startup and to set its priority has been added. 
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7.  Fixes have been implemented to handle the Harmony I/O functions correctly 

    (function codes 222 thru 225). 

8.  The Kit Version information has been added to the "Help" - "About" dialog. 

 

 

CIULink: 

 

1.  The user can specify the range of local ports available to CIULink to bind to 

    in order to open up a communication channel to CIUMon.  This feature is  

    the same as that which was implemented for Hyperview (see #2 in the  

    Hyperview section for more details). 

2.  Time stamp information is now recorded for all points when logging points 

    in Export view, not just the first and last points received. 

3.  The Kit Version information is now available in the "Help" - "About" dialog 

    box. 

 

 

OPC-90: 

 

1.  A new demo version is now available for trial.  It is version 4.2.6 and 

    is found in the RoviSys folder located in your DBDOC installation 

    directory (by default, "C:\Program Files\GMCL\DBDOC\Programs"). 
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Version 9.51 −−−− September 29, 2003 
 

BuildPlus: 

 

1.  Fix Management of Change basefile reference to 

    automatically renamed M14 file. 

 

CIUMon: 

 

1.  Improve checking of physical COM ports for VSP creation 

    and detection to handle internal modems on laptops. 

 

CIULink: 

 

1.  Fix DDE interface with Excel. 

 

Hyperview: 

 

1.  Only log live loop data when requested (set the Option on  

    the "View" tab). 

2.  Clears up some static liveloop display problems that were 

    introduced by changing the size of some static liveloop hotspots 

    and changing of the alignment of others.  Red boxes were not 

    being erased appropriately. 
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Version 9.50 −−−− September 8, 2003 
 

General: 

 

1.  New and improved error filter messages to pinpoint possible 

    problems. 

 

 

Database Utilities: 

 

1.  Blank tags are now suppressed in databases. 

2.  Case-sensitivity of WinCAD tag list names is now handled  

    correctly. 

3.  Short tags are no longer renamed to TAG_X. 

 

 

BuildPlus: 

 

1.  Multiple databases can now be associated to a single console 

    in the Conductor Console Associations.  The compilation 

    handling has been added into Hyperlink to handle this 

    situation. 

2.  Conductor At-A-Glance support has been added into BuildPlus 

    and Hyperlink.  The user may select files in Wizard and 

    then associate the files to the appropriate consoles in the  

    Conductor Console Associations tool. 

3.  Databases extracted from FoxPro databases, along with their 

    corresponding generated error and format files, are now 

    placed in TDTn subdirectories in the TAG folder of the 

    project directory. 

4.  "Display Project Settings and Selections" is a new option that 

    has been added to allow the user to see the file selections 

    and user made associations for projects on either local or 

    remote machines.  For remote use, Administrator privileges will 

    be required if working with NT based machines, while the Remote 

    Registry Service must be installed on the machines if they are 

    Windows 9X based. 

5.  Newly added modules of CAD sheets are now automatically detected 

    by BuildPlus when the project is started from the "Build" stage 

    if they are located in the search path previously specified in 

    Wizard.  The user can choose to add them at the time the build 

    is run or else make changes to the selections by restarting the 

    build from the Wizard stage. 

6.  Improvements have been made in the scrolling code for BuildPlus. 

7.  The option "Enumerate DBDOC Components" has been added under the 
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    "Tools" menu option.  This will generate a file that lists all 

    the currently installed programs and files for DBDOC and 

    their versions.  Any version mismatches will be reported. 

8.  The Database-Graphics Association tool has been modified so that 

    all valid tag and trend databases will be listed for association 

    with graphics paths. 

9.  "Check DeomposerN Directory Sources" displays which numbered  

    Decomposer subfolder in the project directory each selected 

    Composer EBP database was extracted into. 

10. The option to suppress user defined pre- and post-scripts has 

    been added for manual builds. 

11. An additional panel has been added to the Project Specification 

    series of dialogs to show the user which databases have been 

    selected before any processing occurs.  This allows the user the 

    opportunity to confirm his choices before any possibly time- 

    consuming processing begins. 

12. Management of Change processing has been moved to before the 

    Hyperlink run so that the text file listing any changes in the 

    project files may be built into the current M14. 

13. The option to build in symbols and/or submodels as separate 

    chapters in the final M14 has been enabled. 

14. A new /start command line switch has been added to allow the user 

    to specify which build to start a buildall on should he wish to 

    skip the beginning sequence of projects.  Please note that NT-based 

    OS's use alphabetical processing of projects and Win9x machines use 

    chronological order. 

15. Default zip tools are now shipped with DBDOC so that a zipped 

    error file of all pertinent files can be created even if the user 

    does not have WinZip installed on his computer. 

16. The "Processing Options" page has been simplified and any 

    additional options will be listed under the "Advanced Options" 

    page. 

 

 

Hyperlink: 

 

1.  Hyperlink now generates an alarm_tag report of digital tags  

    that will alarm, but that are not on any graphic. 

2.  Unused tags with external sources are now marked with source  

    "External" in the Unused_Tags.txt file. 

3.  Better searching in AutoCAD drawings has been implemented via 

    Fuzzy-Matching so that meaningful substring matches are located. 

    For the sake of compile speed this option can be turned on and 

    off via the Advanced Project Options in BuildPlus. 

4.  A list of rasterized AutoCAD drawings (ones that do not contain 

    any text) is now created. 
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5.  Hyperlink now tests for duplicate imports to the PCU. 

6.  Composer source document references can now be shown as a stacked 

    display on the CAD sheet.  This option can be toggled on and off 

    via the Advanced Project Options in BuildPlus. 

7.  Duplicate Global OREF's are now reported. 

8.  In rendering CAD drawings in Composer systems, Hyperlink will not 

    split wires at connectors. 

9.  More linking support has been added for Operate IT. 

10. New and improved processing of histcfg.xdc files has been added. 

11. Trend:nnnn directive is now processed for links and liveloop 

    monitoring for trended tags. 

12. Support has been added for the point: directive for Conductor NT. 

13. F(x) graphing has been implemented as it is in the Bailey system 

    with respect to out-of-order co-ordinates. 

14. The tag description has been added to the mouse-over datatip. 

15. Blk file support has been added. 

16. Loop, PCU and Module information has been added to error messages. 

17. Exception Report function codes are now handled better. 

18. FC 36 (8-input QOR) is checked to make sure there are enough  

    inputs connected to make it work. 

19. Flat F(x) functions (ones that return a constant) are reported. 

20. F(x) functions with adapted parameters are reported. 

 

 

Hyperview: 

 

1.  Searching has been totally reworked for more intuitive functionality. 

    More advanced search options are now available in an expandable 

    dialog so that the basic search dialog is presented in a cleaner 

    interface for the standard user.  A rebuild of the project is  

    necessary in order to take advantage of the full functionality 

    but it should be noted that this Hyperview is backwards compatible 

    with old M14 versions. 

2.  Make use of Hyperlink generated adapted specs list to compile 

    a bulk "Get Specs" fetch so that adapted values are correctly 

    inserted in the live display. 

3.  Tag attributes can now be displayed.  They work similar to the 

    specs overlay, accessible via the 'A' key. 

4.  The ability to add Live Loop Annotations anywhere in the M14 file 

    has been added.  You can now monitor any point in your system  

    on any document regardless of whether or not that point is actually 

    referenced on the document you are viewing. 

5.  The "Home" button is now configurable so that the home pages of 

    Table of Contents and Topic pane can be set to whatever document 

    the user chooses. 

6.  Within the Options property pages, the user has the ability to 
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    reset the Hyperview settings to their default standard values 

    (ie. those settings that Hyperview would have when run for the 

    first time).  The settings can also be restored to the user's 

    custom settings with the "Restore Preferences" option. 

7.  Icons have been added to the status bar to indicate success or 

    failure of live loop logging and to show informational tips. 

8.  New command line switches, noOpen and snapshot have been 

    added.  /noOpen disables the "Open" menu option under "File"; 

    /snapshot will disable the continuous live loop monitoring  

    button but leaves the snapshot button enabled to allow the 

    user to fetch the live data at the given moment. 

 

 

CIUMon: 

 

1.  New versions of the VSP files are included with this kit. 

    The changes made in CIUMon in combination with these new 

    versions should solve the problem that some users were 

    seeing with the message that the VSP trial period had 

    expired.  CIUMon will detect that different VSP file  

    versions have been installed and will require that the 

    machine be rebooted before any VSPs will work with the 

    new files. 

 

CIULink: 

 

1.  SPM02 support has been added to CIULink. 

 

 

CrypKey: 

 

1.  Blank CAD sheets are no longer counted against the total  

    document count. 

 

 

Support for Other Languages 

 

1.  Documentation of the build messages is available in draft form 

    in French and Spanish. 

2.  Documentation of the Function Code Help information is also  

    available in French and Spanish. 
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Version 9.42 −−−− June 26, 2003 
 

Installation: 

 

1.  The DBDOC installation program now checks to see if  

    the user is logged on with Administrator privileges on 

    Windows NT platforms.  If the user does not have the 

    required privileges the installation will abort. 

 

 

Hyperlink: 

 

1.  Batch file processing has been improved.  A message is generated on 

    missing include files.  The search algorithm for include files has  

    been made more robust so that relative path specifications will yield 

    better results.  Improved batch file title generation to include 

    unit filename, if present. 

2.  Attribute handling in AutoCAD drawings has been corrected. 
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Version 9.41 −−−− May 6, 2003 
 

BuildPlus: 

 

1.  Fix has been implemented to correct the enabling and 

    disabling of the toolbar buttons. 

 

 

Hyperview: 

 

1.  Numeric live hotspots are moved to be right-aligned  

    with respect to their parent hotspots. 

2.  Printing from Hyperview on  Windows NT/2000/XP to a 

    remote Windows NT/2000/XP mounted printer has been 

    fixed.  A remote USB printer is still a problem. 

 

 

CIUMon: 

 

1.  More robust handling has been added to handle error 10038 

    when being run on Windows 2000 platforms which do not have 

    Service Pack 2 or above installed. 

 

 

CrypKey: 

 

1.  Fix has been put into BuildPlus and CIUMon to prevent 

    the license expiry warning dialog box from appearing more 

    than once per day/session. 
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Version 9.40 −−−− April 24, 2003 
 

Composer: 

 

1.  Add version dependent ability to access global field for 

    use in resolving output references. 

 

 

Database Utilities: 

 

1.  Allow databases on CD's to be opened. 

 

 

Wizard: 

 

1.  Special handling for multiple file selections in multiple 

    paths (useful for Conductor customers with multiple units). 

2.  The Table of Contents re-ordering feature is now optional 

    and is defaulted OFF.  This can now be triggered through 

    the BuildPlus project options. 

3.  Fix crash on duplicate selections where unique files/paths 

    are required. 

4.  Fixed reported file sizes for sizes less than 1K. 

5.  Fix crash in "Check Wizard Input Files".  This is still not 

    a useful function to anyone other than GMCL development 

    group. 

 

 

BuildPlus: 

 

1.  The option to add CIUMon settings inline has been added back 

    into BuildPlus.  This option is default OFF and can be  

    triggered through the BuildPlus Options.  The CIUMon settings 

    are also now saved in the registry for future builds. 

2.  Empty files will not be built into your M14.  A list of empty 

    files will be written to EMPTYFILES.TXT and included in the  

    Miscellaneous chapter in your M14. 

3.  Modified time and date has now been added to all file sub- 

    titles (as long as they are not files that have been extracted 

    by DBDOC for the purposes of the present build) in the Classic 

    Table of Contents view in your M14. 

4.  A new BuildPlus option has been added to warn you that you 

    will fall below a certain amount of disk space.   Set the  

    disk space minimum in the BuildPlus options and if you fall 

    below that level a warning will appear asking if you wish to 
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    continue with the build. 

5.  Several new project options have been added:  PI Point Source 

    (specify your own special point source names and associated 

    field names), Error Filter Output Selection (only generate 

    those error files that you are interested in) and Custom Edit 

    (for the advanced user - add any special build instructions 

    especially for AutoCAD color settings). 

6.  If you have chosen XLS databases in the Database Selection 

    panel, BuildPlus will attempt to pre-extract them so that 

    they may be sorted into their appropriate categories (ie. tag, 

    trend, PI, generic, unknown) in the sorting dialog box. 

7.  More project options are stored in the registry which ensures 

    a more consistent build (eg. CIUMon settings). 

8.  The Cat-To-Dog rename interface has been improved so that you 

    may rename any existing project M14.  It is important to use 

    this rename interface rather than manually renaming it through 

    Windows Explorer as BuildPlus will then modify any relevant files 

    to reflect the new name (eg. Management of Change base files). 

9.  Newly generated M14's are now automatically renamed to  

    <project_name>_<date><revision>.M14.  This option may be  

    disabled through the BuildPlus Options. 

10. Project registry settings are now exported to a file after 

    each build and will be stored somewhere in the ERROR_FILES 

    directory (depending on whether you have error file archiving 

    turned on or not).  This option can be enabled or disabled  

    through the BuildPlus Options. 

11. Suppression of some unnecessary warning messages in Management 

    of Change processing. 

12. A new command line switch has been added - /exclude.  This can 

    be used in conjunction with the /buildall switch to exclude a 

    project(s) from being built in a particular build root. 

13. If bad files have been excluded from a build and a new version 

    of Hyperlink has been detected, the user will be queried as to 

    whether or not they wish to attempt to build the bad files with 

    the newer version of Hyperlink. 

14. The file CLDUnused.txt is now created in the DECOMPOSER# sub- 

    directory listing all unused CLD's for a Composer project. 

15. Individual build logs are now created for the /buildall process. 

    The files will be named BuildAll_<build root>_<date>.log. 

16. CAD title extraction has been removed from BuildPlus. 

17. Better state retainment for the Main message and Sub-Process 

    message windows. 

 

 

Hyperlink: 
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1.  Improved RTF parsing - enhanced code for RTF commands. 

2.  Parallel compression of output files in threads to speed end 

    stage of Hyperlink processing. 

3.  Implemented intelligent AutoCAD tag recognition scheme. 

4.  New export_specs feature (dependent on full license) creates 

    one flat database per function code. 

5.  More exception-reporting function codes are handled. 

6.  Fix AutoCAD layout problem by flipping Y axis in drawing  

    functions instead of changing view direction. 

7.  Make an index page for SPECDESC.DBF. 

8.  Handle binapp files up to 4MB in size. 

 

 

Hyperview: 

 

1.  Skip S1 for function generator live data display (graph  

    looked like Etch-A-Sketch). 

2.  New buttons have been added to the toolbar.  The ability to 

    create annotations from the toolbar has been added.  Click 

    the button and click on the document where you want the 

    annotation to appear.  An Audit Window button has also been 

    added to the toolbar.  There is a new Home button which will 

    return you to the classic opening view of your M14. 

3.  "Vegas Lights" have been added to enhance your target viewing 

    experience.  Blinking lights make it easier to spot your  

    hotspot. 

4.  Pop-up menu changes include items for searching and copying. 

    The topic name is now included in the "Mark Topic For Printing" 

    option.  There is also the new option to "Mark linked topic for 

    printing".  The option to minimize and restore annotations has 

    been added as well. 

5.  The Hyperview coordinates are not saved if it is minimized or 

    maximized for restoration the next time Hyperview is opened. 

    There is the option to "Always open Hyperview maximized" 

    which can be set on the "Options..." property pages. 

 

 

CIUMon: 

 

1.  The disconnect functionality has been fixed by resetting 

    the thread priority level to normal.  Commands are no longer 

    accepted when a disconnect is in progress. 

 

 

CrypKey Licensing: 
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1.  Limited functionality has now been added to BuildPlus and  

    CIUMon when your license expires.  In CIUMon, you will be  

    able to delete your VSPs (Virtual Serial Ports); in BuildPlus, 

    you will be able to launch Hyperview, create the Error.zip 

    file, launch Windows Explorer, clean up temporary files and 

    rename M14's.  You will be able to access the license dialog 

    in both programs. 

2.  There is a new dialog which appears when your license expires. 

    You will have to option to license now, license later with a 

    daily reminder, or license later without a reminder. 

 

Contextual Help: 

 

1.  Contextual help has been updated for both BuildPlus and  

    Hyperview. 
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Version 9.31 −−−− February 20, 2003 
 

Hyperview: 

 

1.  A problem with live loop monitoring for non-SPM02 setups has  

    been corrected.  This problem was only introduced in our last 

    version (9.30) and resulted in not being able to fetch live 

    data when the user had a loop setup without a specified PCU 

    entered.  This has now been remedied. 

2.  Previously if the table of contents were shown in Hyperview  

    in Treeview mode and the focus left in the TOC window, when 

    live loop monitoring was turned on, the values would not get 

    updated unless the focus was placed on the drawing window. 

    This problem has been fixed in this version. 

 

Hyperlink: 

 

1.  Hotspot formatting maximum length has been set to the longest 

    tag or document name found to avoid crashing on long text lines. 
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Version 9.30 −−−− February 13, 2003 
 

Installation: 

 

1.  At the end of the installation, a separate program will run 

    to check to see that all the new components have been installed 

    for the current kit.  Any mismatches or missing files will be 

    reported in the DOS window and recorded in DBDOC_reg.log 

    found in the Windows directory. 

 

 

BuildPlus: 

 

1.  Conductor Console Associations and SODG Graphics-Symbols 

    Assocations have been implemented to support the correct 

    generation of these two types of graphics into the final M14. 

    With Conductor NT and/or Operate IT graphics, a user may wish 

    to build multiple consoles of these types of graphics.  If 

    this is the case, BuildPlus allows the user to associate  

    different databases, colordef.dat and fontdef.dat files for 

    the various consoles, as well as specify different .XDC files 

    (graphcfg, trendcfg and histcfg) for each.  For SODG graphics, 

    it is necessary to associate the correct sets of symbols to 

    use in the  build with each set of graphics.  BuildPlus provides 

    an interface in order to make these associations.  For the most 

    part, BuildPlus will try to automatically do the associations 

    in both cases in order to minimize the amount of manual input 

    required to complete the build. 

2.  BuildPlus now checks for the required components before running 

    programs during the build.  If there is a missing file, the user 

    will be informed and the build will not continue.  This will 

    prevent the user from seeing disconcerting failure messages 

    during the build process. 

3.  The user can now set the priority level at which a process  

    will run.  This option is found under the "BuildPlus Options"  

    under the "Tools" menu and controls all non-GUI processes and 

    the Mediaview Compiler launched by BuildPlus. 

4.  A new program, MDBType.vbs, is now run on all Access MDB databases 

    before presenting them in the "DBF and MDB Types Detected" dialog 

    box following the Project Specification panels.  This should  

    correctly sort out which databases are Conductor NT and which  

    are Operate IT databases so that they can be grouped together 

    and processed correctly. 

 

CIUMON: 
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1.  In Windows NT based systems, you can improve the performance of 

    CIUMON by making its priority above normal or realtime.  Consult 

    with your system specialists and observe the affect on other  

    systems carefully, of course. 

 

Hyperlink: 

 

1.  Graph function on Function Code 1 

2.  Batch file processing has been improved.  We now get the loop, 

    PCU and module information from the Address.def file, as well as 

    showing the include files expanded in-line. 

3.  Hotspot formatting has been reworked to provide for better  

    linkages.  Word boundaries are now respected to create more valid 

    links to documents. 

4.  Eudscp.cf exports are now built into the final M14. 

5.  Support has been added for undefined graphics and symbols indices. 

    An undefined tags index has been added to the miscellaneous indices. 

6.  MHD information is built into the M14. 

7.  The module type limits the number of blocks which show up in the  

    block map. 

8.  The RTF compilation error has been remedied by implementing one RTF 

    file per chapter. 

 

 

Hyperview: 

 

1.  Graph function on Function Code 1 is available via the right-click 

    popup menu.  It provides a static view of your custom F(x) and is 

    live-loop capable on a per-graph basis. 

2.  Creating a shortcut to the latest M14 in a project has been made 

    easier with the wildcard feature.  Create a shortcut that has a 

    target pointing at the project directory with *.M14 as the filename 

    and when Hyperview is launched, it will look for the M14 with the 

    newest creation date and open it.  NOTE:  Windows NT, 2000, XP provide 

    file tunneling capabilities so that if you delete a file and create it  

    within the specified caching time period, you will retrieve the file 

    creation time of the original (now deleted) file for your newly created 

    one.  BuildPlus has been modified to insert the correct creation time in 

    any M14 files that you build with this new kit installation.  Old M14 files 

    (built before this installation) may not work with this new shortcut method. 

3.  Annotation support is better. 

4.  TreeView Table of Contents changes have been implemented for better  

    functionality. 

5.  More Bookmark support has been added in Hyperview.  There are now 

    separate pages for defining and managing the bookmarks in an M14. 



 DBDOC Release Notes          
 
 

 
DBDOC for ABB

®
 INFI90

®
 Systems copyright © 1996 – 2012 by G. Michaels Consulting Ltd.   ABB and INFI 90 

are registered trademarks of ABB Automation.    
 
2/29/2012        DBDOC Release Notes — Page 68 of 95 

6.  Improved Live Loop support has been implemented including the  

    configuration of multiple SPM02s.  With SPM02s, this allows the 

    user to specify multiple SPM02s connected to the same loop but  

    different PCU's, thus simplifying communications between Hyperview 

    and CIUMon. 

7.  Modifications have been put in to improve the search capabilities 

    in Hyperview.  The checkstates of the "Show Search Hit Frequency" 

    and "Show Group" options have been retained for the full text and 

    database searches.  The column widths in the search results are 

    retained for subsequent runs and minimum sizing has been implemented. 

8.  Version verification is enabled to provide the best in compatability 

    between built M14's and Hyperview versions that you may be running. 

9.  Print color reversal for Conductor NT graphics has been implemented. 

    If a graphic has a colored background, it will be printed with a 

    white background, by default, to save on ink.  If you wish to dis- 

    able this, check the "No color reversal" option in the "Print" 

    dialog box. 

10. Go To Source handling has been improved.  Double clicks on text 

    panes now take you to the source.  OREF references are now shown 

    in red in the classic and treeview table of contents and are 

    registered as a source for a go-to-source feature. 

11. "Open Document", "Explore to Document" and "Document Path" options 

    are now available on a right mouse click, where applicable.  This 

    allows the user to launch a Windows Explorer page opened up to the 

    directory to which the source file is located or to display the 

    full path to the source file. 

12. Generic binary application support has been added.   

 

 

CrypKey Licensing: 

 

1.  A warning dialog box now appears in both BuildPlus and CIUMon 

    when you have 15 days or less left in your license.  This will  

    allow the user to take the necessary steps in order to ensure 

    uninterrupted use of DBDOC. 

 

OPC-90: 

 

1.  In Windows NT based systems, you can improve the performance of 

    OPC-90 Lite by making its priority above normal or realtime.  Consult 

    with your system specialists and observe the affect on other  

    systems carefully, of course. 
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Version 9.20 −−−− November 1, 2002 
 

Installation: 

 

1.  The installation has changed from previous distribution/ 

    update kits.  There is now only one general kit for both the 

    full distribution and update.  Before the InstallShield is 

    actually launched there will be a setup program which will  

    run first that will back up registry keys, uninstall old 

    versions and delete any remnant files that may be left.   

    InstallShield will then be launched and at the end of the  

    installation, if the GMCL registry keys have been removed by 

    the uninstallation of the old kit, they will be restored. 

    This should resolve any issues that have arisen in the  

    upgrading of the InstallShield program since our version 

    8.43 release. 

 

 

BuildPlus: 

 

1.  Handling for Access MDB databases for Operate IT systems  

    has been implemented.  The "Project Specification" dialog 

    box now shows a general "Access Database" category where  

    the user can specify his Conductor NT and Operate IT MDB 

    databases.  BuildPlus will then present the selected data- 

    bases at the end of the project specification in a treeview 

    so that the user can categorize what type of database each 

    one is.  This allows support of both .XML and .MDB export 

    formats of the Operate IT tag database.  Note that this 

    also applies to Process Portal B. 

2.  The user has the option of configuring the compression level 

    of their M14 build.  This option is available under "Project 

    Options" on the "Processing Options" tab.  It is set at level 

    3 by default (range 0 (none) to 9 (maximum)).  The only  

    reasons to do this are either a very slow computer CPU or a 

    very large system. 

3.  There is now revision information in the "About" dialog. 

4.  The "View M14" dialog box has changed.  You will now be able 

    to scroll horizontally to see really long file names.  You can 

    either select the file from the list and click "OK" or just 

    double click on the file in the list to open it. 

5.  There are two additional command line switches available in 

    BuildPlus - /nomsg and /noview.  The /nomsg switch suppresses 

    any error message boxes that may appear during an automated 

    build.  The /noview switch suppresses the launching of  
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    Hyperview at the end of the build and closes the BuildPlus 

    window after the build regardless of whether the build was 

    successful or not. 

6.  Troubleshoot mode (found in the "Processing Options") is no 

    longer available.  With the implementation of the Treeview 

    table of contents in Hyperview, hyperlink can build in a 

    fully verbose mode without overloading the user with infor- 

    mation in the M14 file.  Note two new commands:  ctrl-T, a 

    command to toggle between treeview and classic views; and T, 

    which collapses the treeview index to the chapter level. 

7.  BuildPlus now allows duplicate module headers if either the 

    PCU or Module is 0. 

8.  ExtTextOut failure (mostly on Windows XP with "switch user" 

    login screen) should not be occurring any longer since text 

    output to the BuildPlus window has been modified to use a 

    different call. 

 

 

Hyperlink: 

 

1.  New AutoCAD support has been implemented in Hyperlink.  The 

    drawing rendering has been vastly improved. 

2.  Hyperlink now has improved batch file support.   Comments  

    are shown in green.  Outputs that appear on their own lines 

    are now linked.   

3.  Honeywell point databases can now be included in your builds. 

    You will need to start from the Wizard in order to include 

    these files. 

4.  Add _N atoms to liveloop capable list for Conductor NT. 

5.  Point source C for PI tags is now being picked up. 

6.  Alias AutoCAD files by their true root name (for example, 

    CS-M-018_01_R04 aliased as CS-M-018). 

7.  In the Classic view of the table of contents in Hyperview, 

    anything that is a source is shown in red (just as in the 

    Treeview table of contents). 

 

 

Hyperview: 

 

1.  The Hyperivew help has been fixed to run off the "Start" 

    button. 

 

 

CIUMON: 

 

1.  Physical-To-Virtual connections have now been added to  
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    CIUMON's handling of virtual serial ports.  The user can  

    now essentially connect a NULL modem cable between a phy- 

    sical serial port and a virtual serial port through this 

    option.  This has been implemented to work with the RoviSys 

    OPC90 Server and the multiplexing of Composer and DBDOC. 

 

 

Wizard: 

 

1.  BLK files are now automatically searched for where CAD  

    sheets occur. 

2.  Wizard has been fixed to handle strange characters (such as 

    an ampersand) in folder names. 

3.  Bailey SODG and user symbols cannot be selected twice (i.e.  

    this means that if you have selected a folder in your Bailey 

    SODG it cannot be selected in your user symbols, and vice- 

    versa). 
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Version 9.10 −−−− September 18, 2002 
 

BuildPlus: 

 

1. Interface to support sorting of DBF type databases. 

2. Insert "Excluded File List" into DBDOC_SUMMARY.ERR. 

3. Remove in-line CIUMON settings dialog.  The adding of CIUMON settings is now only 

accessible through the  Project Options. 

4. The "Create Desktop M14 Shortcuts" now creates shortcuts with UNC named directories for 

the "Start In" directory and the path to Hyperview. 

5. Super secret option to edit .CFG file before launching Hyperlink. 

 

Database Utilities: 

 

1. Support GUID. 

2. Auto-detect for DBF files (DBType.exe). 

3. DBDOC.MDB exports alarm priorities numerically and also exports the alarm group. 

 

Hyperlink: 

 

1.  Build compressed M14's. 

2.  Split contents of the WMF, SMF and HOT directories among  

    subdirectories with no more than 4096 files per subdirectory. 

3.  Fix message indicating apparently circular missing symbol 

    or submodel inclusion. 

 

Hyperview: 

 

1.  View compressed M14's. 

2.  Movable annotations. 

3.  You are now able to suppress the printing of annotations. 

4.  Move sockets calls so that their activation is delayed until 

    the user sets up CIUMON connections. 

5.  Hyperview does not send requests from external blocks to 

    CIUMON. 

6.  Bookmarks are saved and visible whether the topic is  

    available or not.  If the topic is not built into the  

    M14, the bookmark is grayed out. 

7.  Better print abort flag control. 

8.  Re-enabled print selection in text documents. 

 

CIULink: 

 

1.  Fixed export log creation for import into Excel. 
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Version 9.02 −−−− August 28, 2002 
 

Hyperlink: 

 

1. The FillGroup record in Conductor 4.0 M1 files is now 

   handled correctly. 

 

Hyperview: 

 

1. A fix has been put in to correct a problem with the  

   bookmarks, history and pop-up menu for live loop data  

   handling on Windows NT and Windows 95 which was introduced 

   with the new Microsoft Platform SDK. 
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Version 9.00 −−−− July 23, 2002 
 

General: 

 

1. This latest release of DBDOC includes CrypKey software licensing.  With this 

implementation, the user will be  given a 15 day trial period to evaluate the software.  After 

the expiration of the trial period, it will be necessary to contact us to either extend the trial 

period or to obtain a license key with the purchase of the DBDOC  software.  Customers who 

have already purchased DBDOC need only to get in touch with us to obtain a site key. 

2. Rovisys OPC-90 Lite is a new software package that allows for the multiplexing of DBDOC's 

CIUMON access and WinCAD or Composer.  The RoviSys OPC-90 Lite server supports all 

CIU models including the ICT-03 in both serial and SCSI connections to the Bailey Loop.  Its 

ability to multiplex multiple processes to a single CIU is enhanced by our implementaion of 

virtual serial ports.  A trial version has been provided for examination; if you wish to purchase 

a full version of the Rovisys software, please contact us. 

 

BuildPlus: 

 

1. The Project Specification dialog has been improved for 

   easier project setup.  It has been redesigned to resemble 

   more closely the DBDOC Configuration Wizard for file  

   selection. 

 

 

Hyperview: 

 

1. Hyperview now offers the user the option of viewing a Tree-View  

   Table of Contents.  This allows the user to have an at-a- 

   glance overall view of all their documents in a particular 

   M14 file. 

 

 

CIUMON: 

 

1. Error reduction in internal handling improves performance. 

2. CIUMON has been implemented with code licensed from DDI 

   Systems to create and connect virtual serial ports.  This 

   option is only available for Windows NT/2000/XP systems at 

   this time.  The purpose of this feature is to allow the user 

   to add a serial port without actually having to install new 

   hardware; this facilitates the multiplexing of CIUMON and WinCAD 

   or Composer through the Rovisys OPC-90 software mentioned 

   above. 

 



 DBDOC Release Notes          
 
 

 
DBDOC for ABB

®
 INFI90

®
 Systems copyright © 1996 – 2012 by G. Michaels Consulting Ltd.   ABB and INFI 90 

are registered trademarks of ABB Automation.    
 
2/29/2012        DBDOC Release Notes — Page 75 of 95 

Version 8.43 −−−− June 7, 2002 
 

Decomposer: 

 

1. Minor quirks in Composer system processing have been fixed. 

   Problems were found in loop numbers greater than 99. 

 

Hyperlink: 

 

1. Hyperlink now supports 7 character modules correctly. 

 

BuildPlus: 

 

1. Error files generated by hyperlink are now moved into their own 

   subdirectory under the project.  A new directory named "ERROR 

   FILES" is now created and a subdirectory called "Most Recent"  

   will contain those files from the most recent build. 

2. In the "BuildPlus Options...", there is now the choice to  

   "Archive Project Error Files".  When the user turns this option 

   on, BuildPlus will start archiving the hyperlink error files  

   in the "ERROR FILES" directory in subdirectories named after 

   the date that the build took place.  This allows the user to 

   compare the errors between builds.  There is the additional 

   option to "Delete Archived Error Files" which allows the user  

   to delete all files or just those between given dates. 

 

Hyperview: 

 

1. The printing of captions, which was broken in the last release, 

   has now been fixed. 

2. The "Mark Topic for Printing" dialog box now shows checkboxes 

   beside all selections added to the list.  This allows the user 

   the option of selecting or deselecting a full group of documents 

   rather than having to click each individual sub-item.  The dialog 

   box has also been made resizable. 

 

CIUMON: 

 

1. The option to add a caption to the log has been added under the 

   "File" menu option.  When the user has the logging turned on, 

   he now has the ability to add mutliline text into the log file 

   when there is something to be noted. 
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Version 8.42 −−−− May 21, 2002 
 

Database Processing: 

 

1. DBEBP.vbs and DBSynth.exe have been modified to sanitize the exported 

   DBF filenames to exclude illegal characters. 

2. DBMDB.vbs removes prototype tags (starting with ! and having a 0 LPM) 

   from tagdata.mdb. 

 

 

Decomposer: 

 

1. Preserves cross-reference descriptions which are longer than 30 

   characters in Composer systems. 

 

 

Hyperlink: 

 

1. Patch to prevent Conductor popup links from being created from graphics 

   to M2 files. 

2. Additions have been made in order to support the new "Go to Source" 

   feature displayed in Hyperview.  The user must rebuild their project  

   with this new version of Hyperlink and use the new Hyperview in order 

   to take advantage of this feature. 

3. Hyperlink has corrected the handling of "unformatted" live loop values  

   on SODG graphics. 

4. Warning messages on exception reporting imported blocks, e.g. AI/L, etc. 

   have been added. 

5. Hyperlink will reconstitute decomposer-generated long cross-reference 

   descriptions, i.e. it supports 31 and 32 character Composer cross- 

   reference descriptions. 

6. Cleans all messages for non-printable characters. 

7. Extended maximum tag length to 32 characters for the purposes of scanning 

   text for tag links. 

 

 

BuildPlus: 

 

1. The hyperview button is now disabled during the build process. 

 

 

CIUMON: 

 

1. CIUMON has been made somewhat backwards compatible with older versions of  

   Hyperview (pre-May 2nd versions).  CIUMON does not crash when it is  
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   run with an older version of Hyperview and does not cause Hyperview 

   to crash.  However, due to the new request format of the newer Hyperviews 

   the older versions will now only display red boxes rather than the 

   true live data.  In order to get the full functionality, it will be 

   necessary to update the Hyperview version. 

 

 

Hyperview: 

 

1. The "Go to Source" option has been added to the popup menu on a right 

   mouse click for block inputs and outputs.  This allows the user to go  

   directly to the source and brings up the its related block index information. 

2. "Mark for Printing" option has been added to the popup menu to quickly 

   add topics to the list to be printed later. 
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Version 8.41 −−−− May 7, 2002 
 

1.  Patch to fix Conductor NT graphics links. 
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Version 8.40 −−−− May 3, 2002 
 

Overview of Major Features of Version 8.40: 

 

1. Operate IT and Excel XLS support has been added.  Manual creation of  

   an XML database is still required from the SQL server. 

2. The Wizard interface has been modified to improve multiple path handling. 

3. Hyperlink can now generate an M14 in "troubleshoot" mode.  This only 

   applies to Conductor NT and Operate IT graphics at the moment. 

4. Improvements and additions to the Management of Change tools. 

5. Bookmarks and Annotations have been added and improved in Hyperview. 

6. BuildPlus and CIUMON now have property pages for easier navigation. 

 

 

Wizard: 

 

1. Wizard now accepts multiple paths to search in for specified files.  You  

   can add additional search paths by separating them with a vertical  

   bar ( | ). 

2. The "Browse For Folder" now shows the files in the folder not just the 

   folders.  It also shows you the currently selected path at the top of  

   the dialog box when you have chosen a file. 

3. A new panel has been added to the end of Wizard which allows the user 

   to reorder how the chapters appear in the table of contents in the final 

   M14 file.  You are able to drag and drop the topics into the order that 

   you wish them to appear. 

 

 

BuildPlus: 

 

1. Many changes and additions have been made to the Management of Change 

   processing.  Messages have been reformatted in the MOC_DIFFERENCES to  

   provide more useful information to the user as to the nature of the 

   change and the file itself has been renamed to append the date of the 

   comparison.  Two new tools have been added to help the user in analyzing 

   the changes occurring - one allows the user to pick and choose the  

   changed documents to print off within a given comparison and the other 

   allows the user to compare any two base files within a project.  Please 

   refer to the documented help for a more in-depth discussion of these tools. 

2. Operate IT and Excel XLS support has been added into BuildPlus.  The user 

   is able to specify these databases in the Project Specification dialog box 

   in addition to any other databases they wish to build into their M14. 

3. Many of the various tools that appeared under the "Tools" menu option have 

   been placed onto either the newly designed "Project Options..." property  

   pages or the "BuildPlus Options..." dialog box for easier maneuvering and 
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   less complexity. 

4. CIUMON settings can now be directly added to M14 files so that the user  

   does not need to rebuild in order for  the live loop settings to take 

   affect. 

5. You are now able to specify a script to run before or after the build. 

6. Database processing attempts to continue in the event that one of the  

   databases encountered is bad (only in a non-interactive build). 

7. The Hyperview button is enabled at all times in an open project.  It should 

   be noted that if a build is occurring and the user has the project's  

DBDOC.M14 

   file open, the Mediaview compiler will fail as it cannot overwrite the M14. 

   Make sure to close the file before the compiler runs if you are viewing it or  

else 

   rerun from the Mediaview compiler stage to generate the new M14 when you are 

   finished viewing it. 

8. The Troubleshoot mode has been added as an option.  Note that this mode  

   applies only to Conductor NT and Operate IT graphics. 

9. BuildPlus will attempt to be self-correcting in terms of the DAO handling. 

   If it detects that certain keys in the registry are missing or required  

   Data Access Objects are not present, it will try to fix these errors and  

   attempt to continue with the database processing. 

 

 

Hyperlink: 

 

1. Double hotspots on AutoCAD references have been suppressed. 

2. Hyperlink now builds in either developer or troubleshoot mode.  Troubleshoot 

   mode displays only the "interesting" hotspots thus enabling the operator to  

   quickly understand the drawing contents.  Developer mode lists all the  

   hotspots and generally more information than is required for normal analysis. 

   Troubleshoot mode is defaulted on for new projects and can be toggled on 

   and off through the "Project Options..." in BuildPlus.  Note that this  

   feature currently only applies to Conductor NT and Operat IT graphics. 

3. The tagmap feature has been added to identify inconsistencies between 

   databases. 

4. DBDOC URL's have been added to preserve information between builds. 

5. Support has been implemented for Conductor popups. 

6. DXF scaling has been fixed. 

 

 

Hyperview: 

 

1. Bookmarks and Annotations have been implemented and now persist across  

builds. 

   A newly revised and enabled feature which will allow the user to easily docu- 

   ment their drawings. 
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2. Hyperview now recalls the last document viewed in an M14 before closing and 

   will bring up that particular document the next time that same M14 is opened. 

 

CIUMON: 

 

1. All of the options for the CIUMON setup have been changed to appear as 

   property pages to make it easier for the user to maneuver through the options 

   and make changes. 
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Version 8.30 −−−− March 15, 2002 
 

General: 

 

1. The order in which the chapters appear in Hyperview has been 

   changed so that the configuration appears ahead of the symbols. 

   In order to see these changes in effect, the user must rerun 

   the project from the Wizard stage. 

 

Hyperlink: 

 

1. AutoCAD type files are assummed to be DWG type unless they have a 

   DXF extension. 

2. Hyperlink now generates a TagUsage.csv file in the project build 

   directory which contains information about which tags appear in which 

   databases in the system. 

 

Hyperview: 

 

1. The "Mark Topic for Printing" dialog box now presents the user with a 

   treeview interface for groups which the user has selected.  The  

   expanded node shows sub-items within the group which the user can  

   deselect to omit them from printing. 
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Version 8.20 −−−− March 7, 2002 
 

BuildPlus: 

 

1. Management of Change is defaulted on for all new projects. 

2. A fix has been put in to correct a crash which occurred in the 

   previous release of BuildPlus.  Thiss affected users who had not  

   created at least one build root prior to this installation.  

 

 

Hyperlink: 

 

1. Hyperlink is now able to handle colordef.dat files with more than 

   256 colors and fontdef.dat files with more than 11 fonts. 

2. Rtf-escape characters are now added around reference descriptions 

   to avoid potential MediaView crashes. 

 

 

Hyperview: 

 

1. Reduced resource leaks in the printing code have decreased the  

   likelihood of crashes during bulk printing. 

 

 

CIUMON: 

 

1. 2- and 3-digit loop and PCU numbers are now being translated 

   correctly for communication with the CIU. 

2. An option has been added under the SPM02 Configuration settings  

   that allows the user to specify the loop and PCU to which the CIU 

   is connected as the environment fetch upon connecting does not  

   necessarily return the correct information. 
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Version 8.10 −−−− February 22, 2002 
 

BuildPlus: 

 

1. BuildPlus has been modified to simplify program updates for  

   Administrators.  It is now possible to install a central set of 

   programs on a server which everyone can access.  Each person 

   who uses BuildPlus will have their own set of builds local  

   to their machine.  Therefore, when updates are issued for the 

   DBDOC program set, it will only be necessary to update one 

   program location rather than multiple individual users; this  

   will ensure that everyone will be using the latest versions of 

   all the programs to do their builds. 

2. A "Toggle ON/OFF Tag-Scan option" has been added under the Tools 

   menu.  Turning on tag-scan means that attribute (.ATT) files will 

   be generated during the build. 

3. On most of the tool options which require that the project be 

   rebuilt before changes are in effect, the checkbox option of 

   "Rebuild project immediately upon closing" has been added.   

   Once the user has finished making the changes desired and if 

   he chooses to check this option, once the dialog box has been 

   closed, BuildPlus will immediately start the process of 

   rebuilding the M14. 

 

 

Hyperlink: 

 

1. AutoCAD drawings now have automatic live-loop hotspots.   

2. Function code fixes and additions have been implemented.  The 

   function codes affected are 113, 154, 182, 230 and 231. 

3. Hyperlink now generates an unused tag report; this appears in 

   the project directory and is called Unused_Tags.txt. 
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Version 8.01 −−−− February 13, 2002 
 

BuildPlus: 

 

1. Additional information and error messages have been added. 

2. Fixes have been made to the "Build Symbol Paths as Separate 

   Chapters" tool.  Users may exclude paths and change database 

   associations from the default settings and rebuild to get the 

   desired results. 
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Version 8.00 −−−− February 8, 2002 
 

Hyperlink: 

 

1. Memory leaks in AutoCAD handling have been fixed.  Other AutoCAD 

   improvements have been implemented. 

2. Now able to handle both versions of VFY files:  "Block dddd" and 

   "Block Number dddd". 

3. Improvements that have been made in Hyperlink should make for better 

   builds for large systems.  The following changes have been added: 

    

   a.  Module groups are not created unless configuration data (CAD,  

       CLD, ladder, batch) is found for that module.  Blocks that are 

       referenced only by database or graphics are not assigned a group. 

   b.  Index pages, except for the function index, no longer have a  

       browse sequence.  This is a result of eliminating the index/module 

       groups in general. 

   c.  Document-type groups (e.g. CAD sheets, ladder diagrams, etc.) will 

       not be created unless documents of that type are in the build. 

   d.  CAD files are no longer built into their own individual RTF files; 

       rather, all CAD sheets for a given module are built into a single 

       file. 

   These changes should mean that a greater number of documents could 

   be built for a particular project before hitting the MediaView 

   limitation of approximately 16K separate RTF files. 

 

 

BuildPlus: 

 

1. Contextual help has been added to all dialog boxes, as well as 

   a "What's This?" button to the main BuildPlus window. 

2. The bulk of the project file rewrite routines have been removed. 

   Any users who have not updated their programs recently will have 

   to restart their builds from the Wizard stage in order to take 

   advantage of all the new features in DBDOC. 

 

 

Hyperview: 

 

1. Contextual help has been added to all dialog boxes. 

2. The database search has been changed to allow for partial matches 

   on tag names. 

3. Tool tips have been added to text pane hotspots. 
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CIUMON: 

 

1. The format in which the specs are sent to Hyperview to be displayed 

   has been changed from scientific notation to floating point. 

 

 

General: 

 

1. The compiled help has undergone a major reworking.  The file has 

   been broken up into multiple smaller linked help files as well 

   as being reorganized.  A "Frequently Asked Questions" page has 

   also been added for the interest of all users. 
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Version 7.30 −−−− January 18, 2002 
 

Hyperlink: 

 

1. Some error messages have been reformatted, specifically regarding  

   live wires not being connected and duplicate sources. 

2. Apps are now sorted by user name within chapters. 

 

Hyperview: 

 

1. Fix bug where resizing of a window containing a stardard pane, after  

   loading a meta pane, would cause the contents of the pane to disappear. 

2. Minor fixes to improve performance. 

 

CIUMON: 

 

1. An option has been added to the restart dialog boxes where the user can 

   override the value being sent out on bytes 4 and 6 (where applicable) for 

   the restart command.  This is for testing purposes only and should be 

   used in consultation with G. Michaels Consulting. 

 

BuildPlus: 

 

1. Append module header file name to the path displayed in the tree view of 

   the Duplicate Module Header dialog box. 

2. All files that are opened by BuildPlus are now closed when the user  

   presses the STOP button.  This prevents any lockups that may occur 

   on subsequent build runs. 

3. WinZip tool has been fixed for users with evaluation versions of WinZip. 

4. Minor fixes to improve performance. 
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Version 7.22 −−−− January 4, 2002 
 

Hyperview: 

 

1. Additional live loop monitoring options are now available.  Users are 

   now able to view manual live loop data on text files by right clicking 

   on a given point and selecting "Get Output" from the pop-up menu.  As  

   well, a one time snapshot of the live data can be taken by clicking the 

   "Live Loop Snapshot" button on the toolbar. 

2. Accurate hotspot count should rectify problems encountered with some 

   displays. 

3. Search phrase parsing in the "Full Text Search" has been improved.  The  

   user has the option of specifying whether or not to use leading and  

   trailing asterisks in his search phrase. 

 

CIUMON: 

 

1. Fixes have been implemented in order to handle a known Microsoft 

   sockets problem for Windows 2000 systems, i.e. error 10054 and  

   10038.  In order to take advantage of these fixes, those with Windows 

   2000 systems must have Service Pack 2 installed on their computers. 

   Other operating systems are not affected by these fixes. 

2. Additional user option under "Configuration" which allows the user 

   to force CIUMON to send out all commands on key 0. 

 

 

Wizard 

 1. New Appearance 

  

Hyperlink 

 

 1. Improved AutoCAD Representation 

 2. Improved Operator Graphics Representation 

 

Hyperview 

 

 1. Zooming in Audit Window 

 

 

                          BuildPlus 

 

 1. Multiple Database Selections now Implemented 

 

The user now has the option of building multiple databases of the  

same type, for example, two EBP databases and four Conductor 
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databases.   

 

 2. User Interface for Console.cfg File Creation 

 

With the new feature of multiple database handling in BuildPlus, 

it is now necessary to be able to associate the user graphics 

with the correct databases.  In the event of multiple tag and 

trend databases being selected, a dialog box will appear asking 

the user to make the correct associations for their various 

graphics paths.  BuildPlus will then generate a file in the 

graphics directory named CONS_GMCL.CFG with the appropriate 

information so that it can be read on subsequent runs. 

 

 3. New /buildall Functionality from Command Line 

 

If BuildPlus is triggered from the command line with the 

/buildall switch and specified build root, only the projects in 

that specific root will be rebuilt from the RAW stage.  For 

example, 

     BUILDPLUS /buildall C:\BUILD1 

BuildPlus will only build only the projects it knows of in 

C:\BUILD1. 

     BUILDPLUS /buildall 

will build all known projects in all existing build roots. 

 

 4. Additional System Information in DBDOC.ERR 

 

Information regarding hardware and system settings has been added 

into the Project Settings portion at the end of the DBDOC.ERR 

file. 

 

 5. BuildPlus Main Window Message Log Default ON 

 

Messages that are generated in the main message window of BuildPlus 

are being logged into a file called <Project_Name>_<Build_Date>.LOG. 

This file is located in the project directory.  This option is 

always ON by default; if you wish to disable logging, select the  

option under the Tools menu option. 

 

 6. Additional error reporting in Decomposer 

 

Duplicate references to the same IREFs and OREFs are reported. 

 

 

                          Wizard 

 1. New Appearance 
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Due to recent improvements in BuildPlus, Wizard's appearance has 

been streamlined to make choices clearer and less confusing. 

 

  

                          Hyperlink 

 

 1. Improved AutoCAD Representation 

 

AutoCAD 2000 support has been solidified thus rendering more accurate 

graphics.   

 

 2. Improved Operator Graphics Representation 

 

The text in hotspots now reflect the actual symbol names. 

 

 

                          Hyperview 

 

 1. Zooming in Audit Window 

 

When selections are made in the Audit Window the graphic link is 

enlarged in the drawing pane. 
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Version — January 29, 2001 
 

                         Overview 

 

BuildPlus 

 

 1. Main Window Log 

 2. Launch Windows Explorer 

 3. Improved Titles in CFG File 

 4. New DBDOC_SUMMARY.ERR 

 

Hyperlink 

 

 1. Improved Batch File Reference 

 2. Add Aliases for Cross-References 

 3. Improved "No Source" messages 

 

Hyperview 

 

 1. Miscellaneous Text Field in Database Search 

 

 

                           BuildPlus 

 

 

 1. Main Window Log 

 

You now have the option of creating a log of the messages that 

appear in the main message window of BuildPlus.  Select the  

"Log Build Messages" option under the "Tools" menu and enter 

the name of the log file or use the default one provided. 

 

 2. Launch Windows Explorer 

 

Windows Explorer can be launched from the "Tools" menu option. 

If you are presently working in a project, Explorer will be opened 

in that directory. 

 

 3. Improved Titles in CFG File 

 

BuildPlus will parse the DisplayNames.txt file created from the 

Decomposer run in Composer projects and extract the titles created 

there.  These will then be inserted into the project CFG file 

to provide better titles in the final M14 document. 

 

 4. New DBDOC_SUMMARY.ERR 
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DBDOC_SUMMARY.ERR now contains all error and pertinent log files in 

one complete document.  The entries are sorted by time and date,  

from earliest to latest, to provide an overall view of the most recent 

build process. 

 

 

    Hyperlink 

 

 1. Improved Batch File Reference 

 

Unit filenames have now been added to the batch file references 

in the table of contents in the M14 file. 

 

 2. Add Aliases for Cross-References 

 

Hyperlink is able to make cross-references between the CLD and CAD 

names, as well as the DT short filename and long descriptive name. 

This enables you to search by either name in Hyperview's Topic Title 

Index. 

 

 3. Improved "No Source" Messages 

 

The "No Source" messages are now generated and sorted according to 

the type of missing source - whether it was found on a CAD sheet,  

graphic or in a database. 

 

                                Hyperview 

 

 1. Miscellaneous Text Field in Database Search 

 

An additional field has been added to the Database Search -  

"Miscellaneous Text".  This allows you to search for text strings 

in the database, either alone or in combination with any other the 

other fields in the search dialog box. 
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Version — January 19, 2001 

Overview 

This version of DBDOC supports fully implemented ABB INFI-90: 

 

� Composer through Version 3.1, 

� Conductor VMS 

� Conductor NT through Version 2.3 

� WinCAD / WinTools 

� Ladder 

� BATCH 

� CADEWS 

� MCS/OIS and PC View SODG 

Notable New Features 

 

BuildPlus 

1. Specialized Composer, Conductor and WinCAD support. 

2. Multiple Database Support 

3. Full WinCAD / Composer Console Configuration Support 

4. AutoCAD and Text File Association 

 

Hyperlink 

1. Improved Function Code Handling 

2. CAD Titles in Main Table of Contents 

3. Batch File Support 

4. Allen-Bradley RTU Documentation Support 

 

Hyperview 

� Presentation of Bad Quality 

 

CIUMON 

� Improved CIUMON Reliability 

  
BuildPlus 

1. Specialized Composer, Conductor and WinCAD support. 

Buildplus will build the majority of systems (Composer, Conductor and WinCAD) with very 

little additional input.  The Project Type Specification dialog has been created to allow 

specification of meaningful combinations of ABB INFI-90 versions. 

For many current configurations, simply specifying the Composer project, the Composer NT 

access database or the WinCAD FoxPro database will make most of the build occur 

automatically. 
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2. Multiple Database Support 

Support has been added to allow for the selection of multiple databases to be built into 

DBDOC.  Multiple tag and trend lists are supported automatically.  In the case of WinTools, 

Composer and Conductor, they are pre-extracted before the Wizard is run. BuildPlus is able to 

preset some of the Wizard settings in order to simplify the file search. 

3. Full WinCAD / Composer Console Configuration Support 

BuildPlus ensures that graphics are built with the correct database using the Console.cfg files 

which specify the tag and trend databases associated with the graphics. 

4. AutoCAD and Text File Association 

You can now associate AutoCAD .DWG and MicroStation .DXF drawings, plus Text files 

with a specific loop, PCU and module simply by naming the directory in which the files are 

found DXFLPPMM and TXTLPPMM, respectively. 

Hyperlink 

1. Improved Function Code Handling -- Links and hotspots have been added for TSTALM 

function code 69.links have been created for blocks 1 to 9 for function code 70. 

 

2. CAD Titles in Main Table of Contents -- In Composer, the titles of the configuration sheets 

are extracted from the project and used in DBDOC automatically. 

 

3. Batch File Support -- Multiple unit files are applied to replicated copies of the same batch 

document found in the same directory. 

 

4. Allen-Bradley RTU Documentation Support -- Support has been added for the processing of 

AB and RTU files. 

 
Hyperview 

� Presentation of Bad Quality -- Hyperview now presents values that are Bad Quality in a 

muddy yellow hue. 

 
CIUMON 

� Improved CIUMON Reliability -- The reliability of CIUMON has been improved because we 

have learned more about its status messages. 

 

 


